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Chapter 1 
Chapter 1Introduction 

This manual is intended to provide the user with additional information about the 
system, using the system during a clinical procedure, and troubleshooting. This manual is 
a collection of advanced or additional information for periodic use and is provided for 
reference. This is not a procedural manual for using the system. Refer to the User Guide for 
system operation and safety information. 

 

1.1 Warnings, Cautions, and Notes 
Descriptions of Warnings, Cautions, and Notes used in this manual: 

 

 WARNING! The procedures that you must follow accurately 
to prevent possible dangerous or fatal injury. 

 
 

 Warning: The procedures that you must follow accurately to 
prevent injury. 

 
 

 
Caution: The procedures that you must follow accurately to prevent 

the damage to equipment, loss of data, or damage to files 
in software applications. 

 
 

 
Note Notes show additional information. 

 

 
 

1.2 Using this Manual 
The Selenia® User Companion provides the following information: 

How Should I Turn Off the System at the End of the Day? on page 3 provides information for 
system startup and turning off the system. 

Acquisition Workstation Q and A on page 5 provides answers to common questions about 
using the Acquisition Workstation. 

The User Interface on page 23 describes the Selenia operations. 

System Hardware Details on page 99 describes system components. 

The Manager Functions on page 107 provides information for tasks assigned to the manager 
role. 

Troubleshooting on page 129 describes troubleshooting, alarm types, and system messages. 
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Chapter 2  
Chapter 2How to Start Up and Shut Down the System 

2.1 How Should I Turn Off the System at the End of the Day? 
1. Click File (upper left of main screen), then select Exit. 
2. Click the Log out of the Computer option, and then click the Yes button. 
3. Click the Yes button in the second Exit from Acquisition Station dialog box. If a 

message appears that spool jobs are waiting, wait until the jobs are finished. The 
Logout Confirmation dialog box appears. It warns your current session will not be 
saved. Do not be concerned about this message. Click the OK button. The Operating 
System Login dialog box appears. The unit goes into a "Sleep" mode. 

 

2.2 Quick Reminder for System Startup in "Sleep" Mode 
1. Move the trackball to wake the system up. 
2. In the Login dialog box enter reboot for the user name and password. Wait for the 

system to start up. The Logon dialog box appears. 
3. Enter your Operating System user name tech or mgr (case sensitive). 
4. Click the OK button or press the Enter key. 
5. Enter the Operating System password (case sensitive) in the next dialog box. 
6. Click the OK button or press the Enter key. Click the Dismiss button only if the 

system was in "Sleep" mode. 
7. In the Login to System dialog box, click the down arrow and select your name in the 

list. 
8. Click the Password field and enter your password (case sensitive). 
9. Click the OK button or press the Enter key. 

 

2.3 Quick Reminder for System Startup when Completely Off 
1. Press the On button to start the system. The green LED Power On indicator 

illuminates. 
2. Wait for the computer to start up. Do not click the Dismiss button in the Launch 

dialog box. Go to Step 3 above. 
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2.4 How Should I Turn Off the System at the End of the Day? 
1. Click File (upper left of main screen), then select Exit. 
2. Click the Log out of the computer option, and then click the Yes button. 
3. Click the Yes button in the second Exit from acq. station dialog box. If a message 

appears that spool jobs are waiting, wait until the jobs are finished. The Logout 
Confirmation dialog box appears. It warns your current session will not be saved. Do 
not be concerned about this message.  

4. Click the OK button. The Operating System Login dialog box appears. The unit 
enters a "Sleep" mode. 

 

2.5 How Do I Turn the System Completely Off? 
1. Click File>Exit. 
2. Click the Power off the computer option. 
3. Click Yes. If a message appears that spool jobs are waiting, wait until they are 

finished. 
4. Click the OK button at the Logout Confirmation dialog box, "Are you sure you 

would like to power off the computer?" The green LED power indicator turns off. 
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Chapter 3 
Chapter 3Acquisition Workstation Q and A 

3.1 How Can I Switch Users? 
Click the Sign Out button. The Login to System dialog box appears.  

The new user then selects their name from the Identify Yourself drop-down list and enters 
their password. They are signed in. 

 

3.2 What Are the AEC Modes I Have Available for Use? 
There are three AEC modes: Auto-Time, Auto-kV, and Auto-Filter. These modes allow 
various levels of user control of the Automatic Exposure Control techniques: 

Table 1: AEC Modes 

AEC Mode Filter Parameter kV Parameter mAs Parameter 
Auto-Time User selected User selected Determined from 

a scout exposure 
Auto-kV Filter is not selectable. 

Moly tube uses Mo filter. 
Tungsten tube uses Rh 
filter. 

Determined from 
compression thickness 
and look-up table 

Determined from 
a scout exposure 

Auto-Filter Determined from 
compression thickness 
and table 

Determined from 
compression thickness 
and look-up table 

Determined from 
a scout exposure 

 

 
 

3.3 What Exactly Is TEC (Tissue Exposure Control)? 
Tissue exposure control (TEC) exposure mode is designed to take advantage of the 
imaging characteristics of the Selenia® FFDM system, which has significantly higher 
detective quantum efficiency and wider exposure latitude compared to a conventional 
screen-film mammography system. 

When the TEC exposure mode is enabled, the Selenia system uses two parameters to 
compute the optimal x-ray exposure technique: (1) the compressed breast thickness, and 
(2) the estimated breast tissue density. The compressed breast thickness is automatically 
read by the Selenia compression paddle system. The mammography technologist 
estimates the breast tissue density and sets the breast density control to one of the 
following three choices: FATTY, NORMAL, and DENSE. The computed x-ray exposure 
techniques (kV, filter, and mAs) are displayed on the Selenia acquisition display. Once the 
mammography technologist accepts the displayed exposure techniques, the Selenia 
system will change from STANDBY to READY, and an image can be acquired instantly. 
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TEC mode is an advanced MANUAL exposure mode. The mammography technologist 
always has the option to override the computed exposure techniques, simply by manually 
changing one the exposure parameters (kV, mAs, or filter). After the computed exposure 
techniques are accepted or changed by the mammography technologist, the Selenia 
system no longer automatically re-calculates the exposure parameters. The TEC mode can 
be enabled again by changing the breast tissue density control, or by releasing and 
re-applying breast compression. 

 

3.4 What Must I Know to Acquire Images on Patients with 
Implants? 
The wide dynamic range of the digital detector on Selenia systems allows more flexibility 
in selecting techniques for imaging implants. However, image processing does not always 
produce optimal results. When all factors work together, digital images of implants 
contain more diagnostic information and are far superior to screen-film images. 

Image processing on the system uses special algorithms to detect an implant on a digital 
mammogram. A key element contributing to the success of this algorithm is the use of 
correct exposure techniques. Although the digital detector may forgive mistakes in 
imaging techniques, the right exposure range is still necessary to acquire optimum 
images. The following sections provide guidance and recommendations to optimize the 
task of imaging patients with implants. 

Compressing breast tissue that contains an implant is challenging to the technologist and 
the patient. Compression is important and adequate compression must be used when 
imaging patients with implants. Large variations of compressed thickness between the 
implant and the rest of the breast tissue may prevent image processing from correctly 
identifying the implant region. 

 

 
Note Always manually position the AEC Sensor when using AEC 

to image patients with implants. (If you use Auto AEC 
position, the system places an AEC sensor under the two 
densest portions of the breast. In a case with implants this is 
always under the implant.) 
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3.4.1 Method One—Imaging Patients with Implants Away From the Nipple 
The following figure demonstrates a breast with ample tissue in front of the implant. The 
Selenia AEC system may be used in this case to select the exposure techniques more 
accurately because there is enough breast tissue for AEC imaging. You can use the 
Auto-Filter mode and move the AEC sensor manually to the middle of the breast tissue 
area. 

 
Figure 1: AEC Imaging Used for Breasts with the Implant Away From the Nipple 
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3.4.2 Method Two—Imaging Patients with Implants Near the Nipple 
The next figure shows minimal breast tissue around the implant. When there is a small 
amount of breast tissue in front of the implant, the Selenia AEC cannot be used accurately 
because there is not enough breast tissue to use AEC. Part of the implant can interfere 
with the AEC sensor. In this case use the Manual exposure techniques instead of AEC. 

 
Figure 2: Implants Near the Nipple Require Manual Exposure Techniques 

The two tables shown below provide the exposure techniques which apply to patients 
with implants that fall under this category. Do not use the exposure techniques in these 
tables to acquire images of patients without implants or to acquire implant displaced 
views. These exposure techniques were created only for imaging implants with minimal 
tissue around the implant. 

Table 2: Exposure Techniques for Implants Near the Nipple 

Selenia with Tungsten X-ray Tube Selenia with Molybdenum X-ray Tube 

Thickness (cm) kV mAs Thickness (cm) kV mAs 
Less than 4 cm 28 100 Less than 4 cm 28 60 
4 cm to < 6 cm 28 120 4 cm to < 6 cm 28 100 
6 cm to < 8 cm 28 150 6 cm to < 8 cm 28 160 
8 cm to 10 cm 28 150 8 cm to 10 cm 28 200 
More than 10 cm 28 180 More than 10 cm 28 240 
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3.4.3 Method Three—Imaging Patients with Dense Tissue Next to the 
Implants 
When a very dense area is next to the implant, the image processing can detect this dense 
area as an extension of the implant. 

When a dense area next to the implant appears unexposed and part of the implant, the 
following actions can correct the condition and improve the image quality of the dense 
area: 

• When you acquire the image of the implant with METHOD 1, switch to the 
Auto-Time AEC mode and increase the kV exposure technique by 2 kV. Adjust the 
manual position of the AEC sensor if necessary. 

• When you acquire the image of the implant with METHOD 2, keep the same mAs and 
increase the kV exposure technique by 2 kV. 

 

3.4.4 Method Four—Imaging Implant Displaced Views 
The figures below shows the implant completely or partly displaced from the imaging 
area. The Implant Displaced views are equivalent to normal views even though a small 
part of the implant remains visible in the image. Use the Selenia AEC (for example, 
Auto-Filter) to acquire these views. You should use a manual AEC sensor position to 
acquire implant displaced views to avoid interference from part of the implant still being 
present. 

 
Figure 3: Image Implant Completely Displaced 
View with a Manual AEC Sensor Position 

 
Figure 4: Image Implant Partially Displaced 
View with a Manual AEC Sensor Position  
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3.4.5 How Should I Perform Implant Procedures? 
 

 
Note Never use AUTO AEC sensor mode when imaging 

implants. AUTO AEC mode puts an AEC sensor under the 
two densest parts of the breast. In a case with implants, this 
part is always under the implant. When imaging patients 
with implants with AEC, always use a manual position for 
the AEC Sensor location. 

1. Select the Screening Mammogram w/Implants procedure from the drop-down list. 
Check the Implant Present box above the views. Leave this box checked for all views. 

 

 
Note If any procedure tabs contain an ID view, the Implant 

Present button is automatically selected. 

2. Position and compress the breast correctly for an augmented breast. 
3. Acquire the full implant view: 

a. Method One—If the implant is away from the nipple, use Auto-Filter and 
manually move the AEC Sensor to the middle of the breast tissue. 

b. Method Two—If the implant is near the nipple, use a Manual exposure technique 
for the full implant view. Refer to the charts below for recommended exposure 
techniques to acquire an image of an implant near the nipple. The Exposure Index 
will be very low, but you do not need to be concerned. The exposure index is 
measured under the implant. 

Table 3: Recommended Exposure Techniques for an Implant Near the Nipple 

Selenia with Tungsten X-ray Tube Selenia with Molybdenum X-ray 
Tube 

Thickness (cm) kV mAs Thickness (cm) kV mAs 
Less than 4 cm 28 100 Less than 4 cm 28 60 
4 cm to < 6 cm 28 120 4 cm to < 6 cm 28 100 
6 cm to < 8 cm 28 150 6 cm to < 8 cm 28 160 
8 cm to 10 cm 28 150 8 cm to 10 cm 28 200 
More than 10 cm 28 180 More than 10 cm 28 240 

c. Method Three—If the full implant preview includes a dense area next to the 
implant, re-acquire the image: 

• If you used Method One, switch to Auto-Time and increase kV by 2 kV. 
Adjust the manual sensor if necessary. 

• If you used Method Two, keep the same mAs and increase the kV by 2 kV. 
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4. Perform implant displaced views with AEC.  

a. If the implant is in the field of view, place the photocell beyond the implant to 
avoid photo timing through the implant. 

b. If the implant can be almost completely displaced from the imaging area, use 
Auto-Filter. 

c. If a small part of the implant appears in the imaging area, use a manual sensor 
position. 

 

 
Note If you forget to check the Implant Present box on the Patient 

View screen, you may check the box on the Preview screen 
then click the Reprocess Image button at the bottom of the 
Preview screen. 

 

 
 

3.4.6 When I Print Implant Images, What Adjustments Might I Need to 
Make? 
Printed images of the full implants can appear flat or dark if sent to printer as a normal 
mammogram. The following adjustments may be required: 

1. After the case is finished, select Admin>Image/Spool Management. 
2. Find the case. Click all of the full implant views. 
3. Click the Resend selected image(s) button. 
4. Select your printer as the Output. 
5. You can adjust the Contrast/Density for your printer. Change the contrast or density 

with the radio buttons. This change is only temporary for the images you are printing 
now. 

6. Click the Resend button. A message appears which indicates how many images were 
resent. 

7. Click the OK button. 
8. Click the Close button when the printing is completed. 

 

  



Selenia User Companion 
Chapter 3—Acquisition Workstation Q and A 
 
 
 
 
 
 

 
12 MAN-03271 Revision 003  
 
 

3.5 Hints for a Localization Procedure 
The Localization procedure has additional steps not needed in other clinical procedures. 
See Performing a Localization Procedure on page 71 for the procedure. 

• If a paddle other than the Localization paddle will be used, you must turn off the 
Automatic Compression Release. See Standard Setup Screens on page 75. 

 
Figure 5: Compression Release Set at Manual 

• After closing the Standard Setup window, confirm that Manual Release has been 
activated by checking the settings in the lower left hand part of screen. 

• Upon completion of the Procedure, change the Compression Release back to 
automatic if this is the default. Confirm Automatic Release is activated by checking 
the settings. 

• Remove the face shield. 
• To add views, click the Add View button before you begin the exam. (Be aware, any 

additional view is automatically highlighted, so make sure you scroll back to the 
beginning of your procedure and highlight the first view.) 

• Take the scout image using Auto-Filter. 
• Do not use Auto AEC position. Use manual position 2 or 3. 
• If doing a magnification needle localization attach the magnification stand and 

magnification crosshairs. 
• Remember to move the crosshair device or dial the crosshairs out of the field before 

you acquire the scout image. 
 

3.6 What Is the Recommended Exposure Technique for a 
Specimen? 
Refer to the user manuals for the procedure. 

• Position the specimen as close to the chest wall edge as possible. 
• Always use a spot paddle. 
• Use the magnification stand if desired. 
• Take an exposure using the Auto Time and 25 kVp or a manual technique of 26 mAs 

at 25 kVp. 
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3.7 How Can I See Which Patients Are on the CD in the Drive? 
Select Admin>Import, and the patient name is listed in the dialog box. 

 

 
Note The CD-RW is very sensitive. Do Not press the Eject button 

while the system reads from or writes to the disk. 

Check Jobs in Queue to confirm no jobs are waiting to be 
sent before selecting Eject from the Admin menu. 

 
 

 
Note Do not use stick-on labels on a CD. 

 

 
 

3.8 What Must I Do When I Get a Paddle Message? 

  

This message appears if you have an 
incomplete paddle shift. 

 

 

This message appears if your Smart 
Paddle™ is in the wrong position for the 
selected View. 

The system will not acquire an image if the paddle is not installed in one of the three 
positions. The paddle position must match the selected View. Move the paddle to the 
correct position and the message clears. 

 

  



Selenia User Companion 
Chapter 3—Acquisition Workstation Q and A 
 
 
 
 
 
 

 
14 MAN-03271 Revision 003  
 
 

3.9 How Can I Send Images to an Output after the Procedure Is 
Completed? 
See the User Guide for directions, and see Send the Images to the Output Devices on page 51 
for additional details. 

 
Figure 6: Image Management Resend Options 

1. Click Admin>Image (or Spool) Mgmt and select the patient. 
• All the thumbnails in that procedure will be displayed. 
• Click an individual thumbnail to see the available information regarding this 

particular view (displayed in the upper right portion of the window). 
2. Click the Resend tab. 
3. Click the Resend All Images button. 

- OR - 
Select images and click the Resend Selected Images button. 

4. Choose the Output from the drop-down list. 
5. Click the Resend button. 
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3.10 How Do I Edit the Patient Information on Selenia and PACS? 
• The best place to change the patient information is on the HIS/RIS before any 

information is sent to the Selenia. If the images are acquired and sent to the PACS, 
change the information at the PACS. Change Patient Information at the Selenia 
application as a last resort. 

 

 
Note Some RIS systems eliminate the ability to change these errors 

at the Selenia. 

• If the error involved exposing two patients under the same name, it may be necessary 
to read the first patient at the diagnostic review workstation and then delete the 
patient study before sending the second set of edited images, because of the 
information in the DICOM header. 

• Because you can cause a mismatch of information when the Selenia images are sent to 
PACS, work with your HIS/RIS administrator before you make any changes to the 
patient information at the Selenia. 

• You can only change the demographics for a procedure on the Acquisition 
Workstation. Demographics cannot be changed once the procedure is reclaimed. 

• Be sure the incorrect images are still on the Acquisition Workstation before you delete 
them from the PACS. 

• If incorrect images are already accepted and sent to Outputs, prior to sending 
corrected images you must: 
At the SV: Sign on to the SVDX as delete and delete that patient study. 
At the PACS: Contact your PACS Administrator and alert them to delete the incorrect 
study or advise another corrective measure. 

 

3.10.1 Correct the Information at the Acquisition Workstation 
These are some additional hints to change the information on the Patient View screen. 

 
1. In the Patient View screen under Patient (right side of screen) click the Edit button. 
2. If the Accession Number is also incorrect, click the Edit button under Procedure (right 

side middle of figure) and make the correction in that dialog box. 
3. Close the procedure. 
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3.10.2 Resend the Corrected Images to the Outputs 

 
Figure 7: Image Management Resend Options 

1. Click Admin>Image (or Spool) Mgmt. 
2. Display the patient and click the Repreview tab.  
3. Select and save each of the original images. (Follow the procedure in the User Guide.) 

There should now be eight thumbnails (assuming there were four in the original 
study). 

4. Click all of the last four thumbnails (these are the corrected views) and resend them. 
After you confirm that the new images have been sent, you may (at mgr level) go back into 
Spool Mgmt and delete the four images labeled incorrectly. 
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3.11 What if I Reject an Image but Then Change My Mind?  
 

3.11.1 Scenario 1 
• The first image is taken and rejected. 
• The second image is taken and rejected (worse than the first). 
• You'd like to un-reject one of the images. 
1. Click the Review button. A dialog box opens in the upper left of screen with tabs for 

all the views taken. 

 
Figure 8: The Review Button 

2. Click the Tab of interest [ex: RCC] to see all the rejected images for that view. 
3. Click the image that you want to Accept. 
4. When the preview image appears, click the Set Accepted button. 
5. To send to the selected Output, see instructions in Scenario 3. 
6. Click the OK button to close the Review dialog box. 
Only one Accepted image can be housed under one view icon at any one time. 

 

3.11.2 Scenario 2 
• The first image is taken and rejected. 
• The second image is taken and Accepted (sent to outputs when accepted). 
• You'd like to un-reject the first image and add it to the study. 
1. Click the Review button (right side of screen, underneath Jobs in Queue, figure The 

Review Button on page 17). A dialog box opens in the upper left of screen with tabs for 
all the views taken. 

2. Click the Tab of interest [ex: RCC]. There are 2 images: 1 Rejected, 1 Accepted. 
3. Click the Accepted image. 
4. Wait for the preview image to appear, click the Set Rejected button. 
5. When the Image Rejection Information dialog box opens, check the appropriate 

reason. 
6. Click the Reject button. 
7. Now there are 2 rejected images. Click the first Rejected image. 
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8. When the preview image appears, click the Set Accepted button. 
9. To send to the selected Output, see instructions in Scenario 3. 
10. Click the OK button to close the Review window. 

 

3.11.3 Scenario 3 
 

 
Note Any image that was rejected prior to the Close Procedure is 

not sent to CAD. These images may be sent to CAD using 
the Scenario 3 instructions. 

To use this method you must be signed in at the mgr level. 

1. Click Admin. 
2. Click Reject Management. 
3. Click Choose a New Patient. 
4. Select Patient Name tab, in the Patient Name field type in the patient’s name. Click 

Search. 
5. Select the patient. 
6. Click the rejected images you want to send to an output. 
7. Select Resend. 
8. Click either Resend All Images for patient or Resend Selected Images. 
9. Choose the Output from the drop-down box. 
10. Click Resend. 
11. Click Close. 

 

3.12 What Are the Quality Control Tests We Have to Perform? 
Refer to the current Selenia Quality Control Manual for the Quality Control Tests you 
must perform. 

These tests, from the ACR Mammography Quality Control Manual, must still be 
performed: 

• Visual Checklist 
• View boxes and Viewing Conditions 
• Compression Force 
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3.13 Quality Control Hints—Acquisition Workstation 

3.13.1 What Is the Best Way to Organize the Weekly Quality Control? 
Every month you should create a new "patient" for Weekly Quality Control. 

1. Under Patient, click the New button. 
2. For the patient info: 

• For the last name enter: WEEKLY Quality Control 
• For the first name enter: CURRENT MONTH (Jan, Feb, etc.) 
• For the ID, DOB, and Accession Number: Enter the current date (numbers only). 

 

 
Note If you have more than one Acquisition Workstation, you 

should add the room number to the patient ID field. 

3. At the Procedure Description, choose Tech Quality Control procedure from the 
drop-down menu. 

4. Confirm Weekly Quality Control is the default. 
5. Click the Accept button. 

 

3.13.2 How Can I Be Sure My Weekly Quality Control "Patient" Is Not 
Deleted? 
Make sure you Protect your Weekly Quality Control patient. 

1. Select Admin>Protect Patient; search and select the current Weekly Quality Control 
patient. 

2. Click the Protect button, and click the Yes button in the dialog box. 
3. Click the Close button to close the Protect Patient dialog box. 

 

3.13.3 Can I Run the Repeat/Reject Analysis from an Office Computer? 
Setting up an office computer for Repeat/Reject Analysis 

1. Get the IP Address of the Selenia system from Hologic® personnel or your IT Group. 
2. At the Office Computer, log on to Internet Explorer or your web browser. 
3. Enter the web address followed by :8080. 

Example: http://121.7.32.4.10:8080 
http:// [the IP address]:8080) 

4. Click the Return button. 
5. The login screen displays. 
6. Login with user name: admin (case sensitive, lower case). 
7. Click the Logon to the System option. Click Repeat/Reject. 
8. Select the To/From dates and select the technologist. Select the Type (Report). 
9. Click Submit. The report is compiled. 
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10. Once the report finishes, click the Print button to print the report using the browser’s 
print button. 

11. Exit from the web browser when you are done to maintain security. 
 

3.13.4 Can I Save Repeat/Reject Analysis as a Shortcut on a Computer’s 
Desktop 
1. Right click the login page, then click Favorites. The computer prompts you for a link 

name. 
2. Enter Selenia Repeat-Reject (and the Room # if there are multiple rooms). 
3. Once the favorite is saved, click My Favorites. 
4. Highlight the Selenia Repeat/Reject web link you just saved. 
5. Right click to display the dialog box. 
6. Click Send To and another dialog box displays. 
7. Click Desktop (create a shortcut). A shortcut to the Selenia Repeat/Reject Analysis 

Report displays on the computer’s Desktop. 
 

3.13.5 How Should I Empty the Reject Bin and How Often Should I Do It? 
 

 
Note Your Service representative can configure your system to 

auto delete rejected images from the Reject Bin. When auto 
delete is not configured, rejected images must be deleted 
manually. 

Running the Reject report monthly gives the site better control. The American College of 
Radiology requires running this report at least quarterly. 

 

 
Note Always run a Repeat/Reject image report before any 

software upgrades.  

Follow the steps below or starting with Selenia software version 5.2, it can be set up to 
automatically reclaim the rejected images. If turned on, it has a set default of 90 days but 
this is configurable. 

1. You must be signed on as mgr to perform this task. 
2. Click Admin>Reject Management. 
3. Click Rejected Image Report. 
4. Click Search. If message displays, "There are too many results. Please refine your 

search," you must narrow the search: 

a. Enter the Operator’s (Technologist’s) Name. It is their user name for the system, 
which can be their initials. 

b. Click the Search button. 
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5. Click the first item in your Search Results. 
6. Click the Delete Tab. 
7. Click the Delete All for Patient button. 
8. When Confirm Operation box appears, click the Yes button. 
9. Click the Rejected Image Report button. 
10. Click the Search button again. 
11. Click the first item in your Search Results. 
12. Follow Step 7 to Step 11 until you have deleted all rejected images. 
13. Enter the next operator name and delete all of their images. Follow these steps until 

you have deleted all rejected images for all technologists. 
14. Click the Close button (bottom right) to close the Choose an Operator dialog box. 
15. Click the Close button (bottom right) to close the Reject Management dialog box. 

 

3.13.6 Hints for the Flat Field Calibration Test 
 

 
Note Clean the detector and acrylic block before Calibration. 

 

 
Figure 9: The Info Screen 

1. Follow Instructions printed on the screen. 
2. To check the Detector Temperature, click Info>About the Acquisition Station. 
3. On the left side of the Info screen, midway down, look for Temperature. This is the 

current detector temperature. 
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4. If the current detector temperature is not within normal temperature range, between 
20 and 37 degrees Celsius, delay the calibration test until it is within normal 
temperature. 

 

 
Note If you do this test in the middle of the day, wait at least 30 

minutes after the last patient to start the calibration 
procedure. 

5. Click OK to close the screen. 
 

3.13.7 Hints for the Artifact Evaluation Test 
• Select the weekly QC patient and for Outputs select QC Artifact Evaluation. 
• Put a CD in the CD-RW drive if you store your QC on a CD. 
• To use the Zoom/Pan, either hold down the right button and move the 

trackball/mouse or hold down the left button when the cursor is in the thumbnail and 
move the trackball/mouse. 

 

3.13.8 Hints for the Phantom View and SNR/CNR Tests 
• For Outputs, select QC Phantom. 
• If there is an SNR button, these are calculated for you automatically. 
• If there is no SNR button, use the logs and worksheets in the QC manual to record 

your values and calculate your results, then record them on the QC forms from the 
Quality Control manual. 
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Chapter 4 
Chapter 4The User Interface 

This chapter contains additional information about the User Interface available to all 
users. The first part is organized in the order you might use the system. The next part has 
suggestions and hints for clinical procedures. The last part has details about using the 
menu functions and additional information about functions available on the screens. 

 

4.1 Details about Login, Logout, and Shutdown 
When the system is started, the computer performs internal startup tests. If the system 
detects a fault condition during the internal checks, a message displays and startup is 
suspended until the problem is remedied. When the startup tests are complete, the 
Windows Operating System Login dialog box shows. 

Users must log in to the Windows Operating System and to the Selenia Application 
software separately. 

 

4.2 Startup Wait Time 
After login into the Operating system, the application starts and a Launch dialog box 
alerts you that the digital detector is warming up and to wait before starting any clinical 
procedures. The alert does not restrict use of the system before the warm-up time expires. 

The temperature of the Selenia Detector is critical for image quality. To stabilize its 
temperature, the detector should be on for at least 1 hour (warm up) before patient 
exposure. 

• If the system has been off longer than 30 minutes, wait until the message no longer 
displays before acquiring images for clinical purposes. 

• If the system has not been off longer than 30 minutes, click Dismiss. 
 

4.3 System Messages 
The System Message area displays system status and communication between the 
detector and the Acquisition Workstation. The displays in the message area are very 
important when restarting the system after using one of the Emergency Stop Switches 
(discussed later in this chapter.) 

 

 
Note When the application starts, the system evaluates the last 

calibration date. If the date exceeds the calibration period, an 
error message appears and use of the unit is restricted until 
it is calibrated. No patient procedures can be performed. 
Refer to the QC Manual for Calibration procedures. 
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4.4 How to Log Out or Shut Down 
You can exit the software application to log out, 
change users, or shut down the system. 
The dialog box for changing users is available as 
a button on the main application screen or from 
the File Menu (File > Exit). 

 
Figure 10: Sign Out Button 

The File>Exit dialog box presents options to  
shut down or restart the system, log out of the 
Application, or change users. Select the option 
you want and click Yes. Click No to close the 
dialog box. 
The options are discussed in the sections that 
follow. 
After making your selection, follow the 
on-screen instructions. 

 
Figure 11: Exit from Acquisition Station 

Dialog Box 
 

 
 

4.4.1 Power Off the Computer 
Follow the screen instructions to turn off the system.  

 

 
Caution: Do not use a circuit breaker or Emergency Off switch as a 

routine method to turn off the Selenia. 
 
 

 
Caution: Never turn off the Acquisition Workstation or Value 

Console Circuit Breaker except in emergency. The circuit 
breaker can turn off the Uninterruptible Power Supply 
(UPS) and risk data loss. 
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4.4.2 Restart the Computer 
This option restarts the system. After the systems starts, log on to the Operating System 
and then log on to the Acquisition Workstation software. Use this selection for 
troubleshooting. 

 

4.4.3 Log Out of the Computer 
This option exits the Acquisition Workstation application and the Operating System. The 
next user can log in at a different user level. 

Use this function at night to let the system automatically shut down and start up. In the 
morning, log in by typing reboot for the user name and password. When the system 
starts, log in normally. 

 

 
Note Reboot the Acquisition Workstation’s computer daily to 

reset system communication. 
 

 

 
Note If a message appears that there are spool jobs, select log off 

or wait until the jobs are finished. (The spool continues again 
later.) Hologic recommends that you let the jobs to complete 
before shut down. 

 

 
 

4.4.4 Sign In as a Different User 
This option will log out from the Acquisition Workstation, but does not log out of the 
Operating System. This function is the same as the Sign Out button. 

 

4.5 Using the Emergency Off Switches 
There are three Emergency Off switches on the Selenia, one on either side of the Gantry 
and one on the Acquisition Workstation. Do not use the Emergency Off switches for 
routinely turning off Selenia. They only affect the Gantry and should be used only in an 
emergency. 

 

4.5.1 Use the Emergency Off Switch 
1. Press any Emergency Off switch. The power to the Gantry is immediately removed. 
2. If the emergency occurred during a Patient Exam and the patient is compressed, use 

the handwheels to manually release the patient. 
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4.5.2 Restart the System After Activating the Switch 
1. Turn the Emergency Off switch one-quarter turn clockwise. 
2. When the Power Panel dialog box displays, "Communication with the generator is 

lost," examine the Emergency Off Switches and the circuit breaker. 
 

 
Caution: Do not close this dialog box by using the X in the upper 

corner. 
 

3. Click Cancel if the Gantry is already on. 
4. If the Gantry is off, and the Emergency Off Switches and the circuit breaker are set 

correctly, click OK to restart the Gantry. 
5. Click OK again when the Link established with generator dialog box appears. 

 
Figure 12: Panel Power Dialog Box  

If the dialog box reappears: 

1. Observe the Gantry status before you respond to the Panel Power dialog box. 
2. If the Gantry displays are On, click Cancel. 
3. If they are Off, click OK. 
4. After you click OK, a new dialog box, Waiting for link to be established with 

generator, is displayed. 
 

 
Caution: Do not close this dialog box by using the X in the upper 

corner. 
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Figure 13: Waiting for Link 

5. Once a link is established, the message changes to "Link established with generator" 
and an OK button is enabled. 

6. Select OK as soon as this is enabled. 
 

 
Note It may be necessary to click Reset Generator after clicking 

OK if the Generator Problem message isn’t cleared. 
 

 
 

4.6 The Select a Patient Screen 
This screen appears when the application first loads. 

 
Figure 14: Initial Select a Patient Screen with No Patient Information 
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This chart diagrams the choices available on the Select a Patient screen. 

 
Figure 15: Select a Patient Screen Options 

The screen enables you to select a patient from existing databases or create a new patient. 
This section covers additional details about working with the system databases. 

 

4.7 Patient Demographic Database Organization 

4.7.1 Available Databases 
The Selenia Acquisition Workstation has a local database on the workstation computer 
that stores the patient and image data. The Selenia system also can be configured to have a 
network connection to a Modality Worklist Provider. This provider can be queried for 
scheduled patients and their procedures. This process creates a Modality Worklist. 
Selecting patients from the worklist adds them to the local database. 

The Selenia can be configured to communicate with other systems over a network or as an 
independent unit. When connected to a network, Selenia can query a Modality Worklist 
Provider, such as a RIS (Radiology Information System) or PACS, for a list of scheduled 
patients and the Local Exams (the local database stored on the Acquisition Workstation’s 
computer). 
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Note The Modality Worklist is a list of scheduled exams, typically 

maintained by a RIS (Radiology Information System) or 
PACS. For the Modality Worklist to be operational, this 
feature must be installed and configured for your specific 
Modality Worklist Provider. 

When Selenia is not connected to a Modality Worklist Provider, the local database can be 
queried for local exams. If your system is not connected to any PACS or RIS system, there 
are not any Worklist or Local Exams tabs. 

 

4.7.2 Available Patient Lists 
Selenia can display the following types of patient lists: 

1. A list of patients resulting from an "On Demand" query to a Modality Worklist 
Provider (RIS or PACS). 

2. A list of patients in the local database. This list includes: 
• Local Exams. 
• Patients entered locally using the New Patient button. These patients include 

completed and uncompleted exams. 
• Uncompleted patient exams that were originally part of a query to a Modality 

Worklist Provider. 
 

4.7.3 The Acquisition Workstation Local Database 
The local database provides an automatic means to identify patients and temporarily store 
information about acquired studies so that the output from the Acquisition Workstation is 
as accurate and complete as possible. 

Patient identification involves three functions of the Acquisition Workstation: 

• Acquiring Patient demographic information 
• Storing Patient demographic information in a local database 
• Identifying the Patient and associating the correct demographic information with that 

Patient upon examination 
 

4.7.4 Acquisition Workstation Local Database and Modality Worklist 
Provider Interactions 
When the system is configured with a Modality Worklist Provider (MWP), which is 
typically part of a RIS or a PACS, Patient Demographic information may be obtained from 
it. There are three basic interactions between the Acquisition Workstation and the 
Modality Worklist (MWL SCP) functionality: 
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• Local Worklist: The purpose of the Local Worklist is to cache the worklist items 
obtained from the MWL by the query function. It represents a snapshot of the MWL 
SCP’s worklist obtained by the MWL query. The Local Worklist is distinct from the 
Local Database and may contain information that is not included in the Acquisition 
Workstation information for a given Patient.  

• Local Database: The Acquisition Workstation maintains its local database with the 
sole purpose of completely and correctly identifying acquired images. The Local 
Database is updated from a worklist item when a worklist record is selected.   

• Synchronization: The Acquisition Workstation synchronizes the Local Worklist and 
the Local Database when you select a worklist item(s). At Synchronization time, if the 
information from the selected worklist is found to be inconsistent with the local 
database, you are given the option of resolving the inconsistencies via a dialog box 
showing both Local and Worklist data. Inconsistencies are not resolved automatically.  

For help with Worklist Problems, see Worklist Problems on page 142. 
 

4.8 Working with the Databases 

4.8.1 Using the Bar Code Scanner 
The Acquisition Workstation supports a single bar code scanner that identifies a Patient 
already in the Worklist or the local database. Scanning a bar code automatically generates 
a query to match the Patient ID or Accession Number (whichever is configured). It queries 
whichever database is selected before the bar code is scanned. 

 

4.8.2 Querying Modality Worklist Connections 
In sites with a Modality Worklist Provider, select the Worklist tab (if it is not already 
highlighted) to query the MWP. 
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4.8.3 Querying the Modality Worklist Provider 

 
Figure 16: Fields Used to Filter a Query to the Modality Worklist 

To query for a Patient from the Modality Worklist Provider: 

1. Click the Worklist tab. 
2. To input the query information: 

a. Bar Code Scanner—scan the patient ID bar code. The patient’s scheduled 
procedure displays and the patient is added to the local database. 

b. Keyboard—one or more fields may be used to query the Modality Worklist 
Provider. Enter the information and click Query or press Enter. The search results 
display on the screen. 

A sample query for a patient scheduled 
for today’s date (enter into the 
appropriate field): 

• The patient’s name: 
• Patient ID: 
• Accession Number: 
• Requested Procedure ID: 
• From the Date drop-down 

menu select today. 
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Figure 17: Results of the Patient Query 

 

• If you changed the date from the ‘today’ default, you 
can click Today’s Worklist tab to display today’s 
appointments. 

• The Patients who are scheduled for today and meet the 
criteria you specified display on the screen. 

 

 

 
Figure 18: List of Patients From the Today’s Worklist Query 

3. Select the patient to open their procedure. 
4. If your search for a single match with a patient ID or Accession Number is successful, 

the patient’s Procedure opens automatically. 
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4.8.4 Searching Local Exams—Acquisition Workstation Local Database 

 
Figure 19: Selected Patients Appear in the Local Database, Local Exams Screen 

Patients and related information are kept temporarily, storage space availability 
permitting, in the local database to save having to re-enter information for a recently 
x-rayed Patient. 

 

4.8.4.1 How Patients Are Added to the Local Database 

The Acquisition Workstation Local Database acquires a Patient/exam entry by: 

• Manual Creation: Creating a new Patient/exam at the Acquisition Workstation. 
• Modality Worklist: The selection of a worklist item from a list of items obtained by 

querying a DICOM Modality Worklist Service Class Provider (MWL SCP).    
 

4.8.4.2 Search the Local Exams 

1. To search for a Patient in the Local database: 

 
Figure 20: Selecting an Existing Patient from a Search List 

• Click the Patient Name or ID tab. Enter the Name or ID in the Search box and 
either click Search or press Enter.  
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• You can also enter part of a name or ID number and click Search. If you are not 
typing the first part of the ID, you must put an asterisk in the beginning of the 
name or ID to stand for the part that you did not enter. 

 
Figure 21: Typing a Patient Name in the Search Field 

The system searches its local database for the Patient or Procedure ID and displays the 
list of patients matching the search criteria. 

2. Select the Patient in the list. 

 
Figure 22: Select a Patient Screen 

• Their procedure opens in the Patient Views screen. 
• If the Patient has more than one Procedure scheduled, the Choose a Procedure 

Screen displays with a list of their procedures. 
 

4.8.4.3 If the List Is Too Long 

If your results give a very long list, you may get an error message. Include more of the 
name or ID number and try searching again. If the list is long, you can search for an exact 
name or Patient ID. 

1. Select the appropriate tab. 
2. Enter a name or ID, or partial name or partial ID, in the field to the left of the Search 

button. 
3. Click Search. The resulting list contains only those Patients that meet the requested 

criteria. 
4. Select the Patient you want from the shorter list. 
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4.8.4.4 Guidelines for Entering Names in a Search 

Note the following guidelines when entering names:  

• Names are stored in the database as LAST^FIRST^MIDDLE. You must include the 
caret (^) character between the name parts (for example, DOE^J*). 

• Because names are stored in the format LAST^FIRST^MIDDLE, to search for the first 
name Jane you must use an asterisk (for example, *Jane). 

• Search entries are not case sensitive; you can enter upper or lower case letters. 
 

4.8.4.5 Patient Not Found 

If there is no match, the No Patients Matching Query dialog box appears. 

 
Figure 23: No Patients Matching Query Message 

 

 
 

4.8.5 Searching Patient Data on a System Without a Worklist 
The Acquisition Workstation Local database contains the demographic information for 
un-reclaimed Patients examined on this system, and selected patients from the Worklist 
Patient Query. The Worklist/Local Exams tabs do not exist if your system is not 
configured for a Modality Worklist Provider. 

1. Select the Patient Name or Patient ID tab, enter the information to search for, and 
click Search. The search results are listed. The arrows on the left side of the screen 
assist in scrolling through the list. 

 
Figure 24: Search for a Patient in a System Without a Worklist 

2. Select the Patient from the list. The patient’s procedure displays in the Patient View 
screen. 
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4.9 Choose a Procedure 
 

 
Note A Procedure ID tracks a Procedure (series of images). This 

ID relates the images to a particular Procedure and Patient. 

This option only appears when the patient has more than one scheduled procedure. 

 
Figure 25: Choose a Procedure 

 

Figure Legend 

1. List of Procedures for a Patient with more than one scheduled Procedure. 

2. Select button to open the procedures you have selected. 

3. Close button to close the Patient without opening any Procedure. 

4. New button to schedule a new Procedure. 
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4.10 Patient View Screen 

 
Figure 26: Patient View Screen Panes 

Figure Legend and section where discussed: 

1. Patient View Icons Pane, Implant Present: Implant Present on page 45  
2. Patient Pane, Edit button: Edit Patient Data on page 60 
3. Procedure Pane 

• New button: Add a New Procedure to an Existing Patient on page 60 
• Edit button: Add a New Procedure to an Open Patient on page 61 
• Add button: Add a New Procedure to an Open Patient on page 61 

4. Outputs Pane: Select the Output on page 43  
5. Special Mode Buttons 

• Non-Imaging Mode button: Non-Imaging Mode Button on page 63 
• Simulate Capture button: Simulate Capture Button on page 64 
• Review button: Review Button on page 64 

6. Exposure Information and Techniques Pane: Selecting Exposure Modes on page 39   
7. Generator Pane 

• Generator Status: Acquiring Images on page 43 
• Generator Error Message: Generator Related Alarms on page 131 
• Reset Generator button: Digital Image Receptor Related Alarms on page 131 

8. System Messages Pane: Tables of Messages and User Actions on page 134 
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4.10.1 Patient View Screen Options 
This chart diagrams the choices available on the Patient View screen. 

 
Figure 27: Patient Views Options 

The next step in the normal workflow is to select an exposure mode for the procedure. 
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4.10.2 Selecting Exposure Modes 
Selenia functions in these Exposure Modes: 

 
Figure 28: Exposure Modes 

To choose the mode, click the up/down arrows in the Exposure Mode pane (the lower, far 
left box). The exposure defaults for that mode appear to the right in the pane. For more 
information about setting defaults, see Set Technique Defaults Screen on page 75.   

Use the trackball or the function keys to change Exposure techniques. 
 

 
Note Changing the mode resets all Exposure Techniques to the 

defaults for that mode. 
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4.10.3 AEC Exposure Mode 
AEC is calibrated to give a set dose for a standard breast (50/50, 4.5 cm thick). During 
AEC, the kVp is calculated by the set AEC table as a function of compression thickness. 
The pre-exposure (50 milliseconds) is used to calculate the mAs. During the pre-exposure, 
the resulting pixel value is evaluated and the appropriate mAs that produces a targeted 
pixel value is determined. 

 
Figure 29: AEC Modes—Choices That Must Be Made by the Technologist 

 

Table 4: AEC Mode—Available Selections 

AEC Mode Techniques 

Auto-Time 
Filter = user selected 
kV = user selected 
mAs = calculated from Scout Pulse 

Auto-kV 
Filter = not selectable (Mo if Mo tube, Rh if W tube) 
kV = calculated from compression thickness and lookup table 
mAs = calculated from Scout Pulse 

Auto-Filter 
Filter = calculated from thickness and lookup table 
kV = calculated from compression thickness and lookup table 
mAs = calculated from Scout Pulse 

 

 
 

4.10.3.1 Auto-Time Mode 

In Auto-Time mode, select all exposure factors except mAs, and use Auto AEC or select 
the AEC Sensor Position. Auto-Time terminates the exposure after the AEC circuitry 
senses a pre-determined amount of radiation. A final mAs value displays after the 
exposure. 

 

4.10.3.2 Auto-kV Mode 

In Auto-kV mode, the system automatically selects the exposure kV and mAs. Once you 
select the Focal Spot and the AEC Sensor position or Auto AEC, the system is ready for 
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the exposure. A Final kV, Post-mAs value, and Filter selection displays after the exposure. 
(The Filter is not selectable; the filter defaults to Mo if the system is configured with a 
Molybdenum x-ray tube and Rh if configured with the Tungsten x-ray tube.) 

 

4.10.3.3 Auto-Filter Mode 

In Auto-Filter mode, the system automatically selects all the Technique factors. Once you 
select the AEC Sensor position or Auto AEC, this is a fully automatic operation. The 
system automatically sets the kV using the lookup table based on the compressed breast 
thickness and changes the filter type when indicated by the table. A Final kV, Post-mAs 
value, and Filter selection displays after the exposure. 

 

4.10.3.4 AEC Exposure Adjustment Settings 

If you increase or decrease the targeted pixel value by using the Exposure Adjustment 
Settings, each step changes the target pixel value by approximately 15% which 
corresponds to a change in dose of the same magnitude. 

The control range is from +4 to -3 to increase or decrease the exposure. Each step 
corresponds to a 15% change in exposure from the previous step. The calculated mAs 
increases or decreases with this change and remains until you change it or reboot the 
system. 

 

 Warning: You increase the patient dose to high levels when 
you increase the AEC exposure adjustment. You 
increase the image noise or decrease image quality 
when you decrease the AEC exposure adjustment. 

 

  
 

 Warning: An increased exposure adjustment leads to a higher 
dose to the patient. Keep the patient dose as low as 
practical to get good image quality. 

 

  

 
Figure 30: AEC Exposure Adjustment Setting on Screen 

 

 
 



Selenia User Companion 
Chapter 4—The User Interface 
 
 
 
 
 
 

 
42 MAN-03271 Revision 003  
 
 

4.10.3.5 AEC Sensor Position Indicator Settings 

You can select one of the seven positions to define the area of interest for AEC 
calculations. You can also select Auto AEC where a larger area is evaluated for the densest 
areas of the breast, and those are considered for the AEC calculation. 

 

 
Note Always be aware of the position of the AEC Sensor when 

making AEC exposures. 

Set the AEC Sensor Position after compressing the breast. There are three ways to change 
the AEC Position selection: 

• The buttons on the compression device. 
• The AEC Pos key on the keyboard. 
• The AEC position arrows on the Acquisition Workstation display. 
The displays on the side of the Compression Device and the lower right corner of the 
screen indicate the position setting. 

The AEC Sensor Position has eight available positions. 

• Positions 1 through 7 are manual selections, from the chest wall edge (position 1) to 
the nipple edge (position 7). 

• Position 8 (Auto) automatically positions the sensor after sampling, and adjusts the 
sensor position for the two 1 x 1 cm regions.   

The AEC Sensor uses areas of the detector rather than physical radiation sensors used in 
screen-film systems. There are two types of AEC Sensors. The Fixed AEC Sensor is used 
when a selection from 1 to 7, corresponding to the markings on the screening paddles, is 
selected. Manually selected Sensor positions do not change from your selection unless the 
collimator size decreases. This happens when: 

• A smaller compression paddle changes the collimator. 
• Shifting a paddle will change it to Auto AEC Position. 
• The collimator override is used to select a smaller size. 
Then, if necessary, the AEC sensor position moves to just within the field. (This change 
does not occur when the collimator size increases.) 

The Auto AEC Sensor covers a larger area. A detector region, with a size defined by 
paddle and shift position, is used. This region is divided into approximately 1 cm2 areas. 
Auto AEC positions one sensor beneath the densest part, the second sensor beneath the 
next densest area, and then averages them. 

When viewing an AEC Preview, you can display the AEC Sensor area(s) without regard 
for which method, Manual or Auto Sensor, was used for the exposure. See the figure AEC 
Exposure Adjustment Setting on Screen on page 41. 
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4.10.4 Select the Output 
To change an Output, select a new output from the drop-down list. When you change the 
Outputs option, a dialog box appears, informing you of the change. Click OK. If you select 
an output with no destination devices, the dialog box asks if you really do not want any 
outputs. If this was a mistake, reselect the output. Outputs can be a group of outputs, for 
example, a diagnostic review workstation and CAD, a combination of printers, and an 
archive system. For more details about outputs, see What Must I Know to Acquire Images on 
Patients with Implants? on page 6. 

 

 
Note Only accepted Images are sent to the outputs. Rejected 

Images are sent to a storage area. 
 

 
 

4.10.5 Implant Present–Patient View Screen 
If the patient has an implant, select the Implant Present check box above the views. All the 
images are marked as having an implant and Implant Processing is applied to all views 
until the box is unchecked or you close the procedure.  

 

 
Note Select the Implant Present box for all Implant views and 

Implant Displaced (ID) views. 
 

 

 
Note For full Implant views, use either AEC (Auto Filter) or 

Manual Exposure Modes. For Implant Displaced views, use 
AEC and manual placement of the AEC sensor. See What 
Must I Know to Acquire Images on Patients with Implants? on 
page 6. 

 

 
 

4.11 Acquiring Images 
The system is ready to acquire Images when the Generator Status indicates "Ready" and 
the X through the x-ray symbol in the Generator Status box is not displayed. The 
Generator Status Message changes during the X-ray: Boost, Rotor, X-ray On (the 
high-pitched tone starts), X-ray Off. 

 

 Warning: Do not move the C-arm while the system retrieves 
the image. 
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4.12 Working with Images 
You use the Preview Image screen to: 

• Evaluate the Exposure Index and the Preview Image 
• Add Comments 
• Edit the View 
• Make enhancements with the Preview tools 
• Accept and reject images 

 

4.12.1 Preview Image 

 
Figure 31: Image Preview Screen 

The Acquisition Workstation proceeds into the Preview mode as the image is processed. 
The Preview Image is a non-diagnostic version of the image with processing applied for 
confirming anatomy and positioning. The Image pane displays how the image looks at the 
output device, scaled down 4:1. The Patient Name, ID, and View appear on the top bar of 
the Preview. 

You may apply Window/Level adjustments or use other Preview tools located on the 
right side of the screen. Any changes to the Window/Level will not be saved to Outputs. 

 

4.12.1.1 Progressive Preview 

Generally, the first preview image is available in a short time for a quick evaluation of 
positioning. This first preview image updates with an improved preview image, which 
provides better image quality to evaluate motion or image artifacts. 
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4.12.1.2 Film Label Area 

The small rectangle in the upper left corner is the film label area and is blank in the 
Preview. The label box is shown to ensure that there is no anatomy underneath the box, 
since that is where the label appears if the image is printed.  

 

4.12.1.3 Digital Markers 

A Digital Marker next to the label appears automatically. The technologist’s initials are 
displayed and the chosen View selects the appropriate marker. You can click and drag the 
marker or change it using the Markers buttons on the Tool Bar.  

 

4.12.1.4 Hanging Options 

Images are presented on the screen as chest wall on the right or left (Dorsal or Ventral.) 
The graphics in this manual are all in chest wall on the right (or Dorsal) mode. 

These options can affect how images display on your diagnostic review workstation and 
should be confirmed with the Vendor. 

 

4.12.2 Comments 
The Comments button allows you to enter or modify Image Comments during the 
Procedure while the Preview screen is open. The exact comment text is copied into the 
DICOM header of the Acquired Image. The diagnostic review workstation displays any 
comments. The comments can be printed on film output from the diagnostic review 
workstation.  

 

 
Note Clicking Clear Comments removes all of the image’s 

comments. 
 

 
 

4.12.3 Implant Present 
A check box was available in the Patient View screen to allow you to mark when an 
implant is present. The Preview screen displays an Implant Present check box which you 
can select or unselect to change the information. 

 

 
Note If any procedure tabs contain an ID view, the Implant 

Present button is automatically selected. 
 

 
 

4.12.3.1 How to Correct Implant Information Before You Accept the Image 

If you realize the implant information on an acquired image is incorrect before you accept 
the image: 

1. Click the Implant present check box on the Preview Screen. 
2. Click the Reprocess View button on the bottom of the preview screen. The image is 

reprocessed and you can then click Accept. 
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4.12.3.2 How to Correct Implant Information After You Accept the Image 

If you realize the implant information is incorrect and you have already accepted the 
image: 

1. Repreview the image by clicking the thumbnail. 
2. Select or unselect Implant Present on the Preview screen. 
3. Click the Reprocess View button. 
4. Click Save. A Send Image to Output dialog box asks you to confirm that you want 

this image sent to the selected outputs. 
• If you click Yes, images are sent to the selected utput(s) group. 
• If you click No, the image can be resent using Image/Spool Management. 

5. The incorrect image was sent to the chosen outputs. Corrections must be made and 
then you must use Image or Spool Management and resend the corrected image. See 
Using the Repreview Option on page 87. 
• If you printed the image, collect and discard the incorrect image. 
• If the image was sent to a diagnostic review workstation, delete the incorrectly 

processed image. 
• If the image was sent to the PACS, contact the PACS administrator and have them 

delete the incorrectly processed study. 
 

4.12.4 Zoom/Pan 
Two methods of Zoom/Pan are available: Quick Zoom/Pan and Full Zoom/Pan. 

 

4.12.4.1 Quick Zoom/Pan 

When Quick Zoom/Pan  is active, a magnification of the Preview Image 
displays using the entire Preview area. The magnification factor depends on the paddle. 
The 24 x 30 cm paddle has less magnification than the others. The placement defaults on 
the centerline of the chest wall. Activation and deactivation of this feature does not affect 
any crosshairs or line measurements. 

 

4.12.4.2 Full Zoom/Pan 

Full Zoom/Pan  is available after the final image is prepared. When Full 
Zoom/Pan is active, a 70-micron magnification of the Preview Image is shown using the 
entire Preview area. Each pixel of the image display represents a detector pixel. Activation 
and deactivation of this feature does not affect any crosshairs or line measurements. 

This thumbnail view, seen at the upper right part of the screen, indicates where the 
magnified view is located in relation to the entire image. You can drag this box to get to 
where you want to be in the image. 

 



Selenia User Companion 
Chapter 4—The User Interface 

 
 
 
 
 
 

 
MAN-03271 Revision 003  47 
 
 

4.12.5 ROI 
ROI Statistics dialog box shows the: 

• Location of the left, top, and the width and height of the ROI box in pixel units. 
• Minimum and maximum pixel value within the ROI box. 
• Mean, standard deviation, and Signal-to-Noise ratio (SNR) measurements for the 

ROI. SNR does not compensate for the DC offset and should not be used for QC. 

 
Figure 32: The ROI Statistics Information on the Preview Screen 

 

 
 

4.12.6 Measurement 
This feature measures distances on the image. 

1. To clear the line, click the ‘+’ at either end of the line. 

2. Click the Measurement tool  to turn Measurement off or to hide the 
numbers. 

Note the following: 

• Turning the Measure tool off does not clear the caliper lines. They are 
automatically cleared when the Preview window is closed. 

• Caliper lines are not saved or recalled. 
• You can draw multiple lines. 

 

4.12.7 Magnification 
Magnification of the image is available with a short delay after the image appears. The 

button labels appear when this option is available. Using the Magnifier  , you 
can view part of the image at 2X the currently displayed resolution. 

A full resolution view of a part of the image is available when the Acquisition 
Workstation receives the entire image. You can also use the magnifier on that full zoom 
image after locating an area of interest and clicking the magnifier to further magnify that 
area. 

 



Selenia User Companion 
Chapter 4—The User Interface 
 
 
 
 
 
 

 
48 MAN-03271 Revision 003  
 
 

4.12.8 Window/Level 
 

 
Note This operation has no effect on the final processed Image. 

 

 
Figure 33: Changing the Window/Level Settings 

 

You can edit the Window/Level  by clicking in the box you want to change and 
entering a new number. When you click Set the image display changes to the new setting. 
Double click the image to return to the original setting.  

 

4.12.9 Cropping 
The Acquisition Workstation images are acquired with a collimated x-ray source. When 
an 18 x 24 cm or smaller paddle is installed with automatic collimation, the system crops 
the image to 18 x 24 cm. The area outside is not stored. You cannot change cropping. 
When manual collimation is selected, cropping follows the field. 

 

4.12.10 Accept or Reject Images 
   

 

4.12.10.1 Accept Button Details 

 
Figure 34: The Accept Button 

When you accept the Preview Image: 

• The full resolution image with all associated attributes is marked as accepted in the 
spool space. Acceptance "freezes" the Acquired Image, and no subsequent action 
changes any attribute of an Acquired Image. It can be rejected later. 

• The system transmits the image to the selected destination output devices. 
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4.12.10.2 The Image Repetition Information Dialog Box 

When you have already accepted an image for a view and then acquire and accept a 
second image for the view, the Image Repetition Information dialog box appears. Except 
for the choices Body Habitus and Wire Localization, the information collected here goes in 
the Repeat/Reject report count for the logged-in technologist. 

Select the reason for the repeat and close the dialog box. 
 

4.12.10.3 Reject Button Details 

To reject an image: 

1. Click Reject. An Image Rejection Information dialog box appears, listing possible 
reasons for rejection and providing a text field for typing a reason.  

2. Select a reason for rejection. 
 

 
Note This information is used in the Reject Analysis (required for 

Quality Control.) 
 

3. Click Reject to close the dialog box, or click Return to Preview if you decide not to 
reject the image. 

 

The system moves the image to the Reject Bin. 
4. After you reject an image, the Preview closes and you can: 

• Re-acquire the rejected View. 
• Select a different View. 
• Close the Procedure. 

An asterisk is displayed next to the view label of any views with 
a rejected image. 
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4.12.11 Accept a Rejected Image 
You can reverse the Rejection process at any time. If you reverse the rejection process 
before the procedure is closed, the change is reflected in the Reject Analysis Report. If you 
reverse the rejection process after the procedure is closed, the change is not reflected in the 
Reject Analysis Report. 

If you decide that a rejected image is better than the new image: 

1. Reject the second image following the steps in Accept or Reject Images on page 48. 
2. In the Patient View screen, click Review (below the Outputs box). 
3. In the Review dialog box, select the View tab for the View. (For example, R MLO).  
4. Click the Rejected Image thumbnail you now want to accept. A preview image 

appears.  
5. Click Comments if you wish to add or delete comments. 
6. Click OK to close the Comments dialog box. 
 

7. Click Set Accepted. 
8. Click OK to close the Review dialog box. The accepted 

image appears as a thumbnail on the Patient View screen.  

 
Figure 35: Accept Rejected Image 

 

 

    
 

4.12.11.1 Sending Accepted Rejected Images to Outputs 

When you accept a rejected Image, you must confirm that you want this Image sent to the 
selected outputs.  

• If you click Yes, Images are sent to the selected output(s) group. 
• If you click No, the image is not sent. It can be resent using Image/Spool Management 

at a later time. 
 

  



Selenia User Companion 
Chapter 4—The User Interface 

 
 
 
 
 
 

 
MAN-03271 Revision 003  51 
 
 

4.12.11.2 Reject an Accepted Image 

If you decide to reject the Accepted Image: 

1. In the Patient View screen, click Review. 
2. In the dialog box, select the View tab for the View you are rejecting.  
3. Click the Accepted Image. The Preview screen displays. 
4. Click Set Rejected. The Image Rejection Information dialog box appears.  
5. Choose a rejection reason. 
6. Click Reject. The system reprocesses it and labels this image rejected. 
7. Click OK. The displayed thumbnail disappears from the Patient View screen. 

 
Figure 36: Set Rejected Button 

 
 

 
Note After you reject an Image using this method, it is not 

removed from the outputs destination queues, for example, 
diagnostic review workstation, or archive. It can be deleted 
from the queues. See Manage Queues on page 89. The 
Rejected Image is added to the reject analysis bin for 
tracking purposes. 

 

 
 

4.13 Working with Images After They Are Accepted 

4.13.1 Send the Images to the Output Devices 
After you accept an image, the Acquisition Workstation sends the image to the destination 
devices in the selected output. The system makes entries in all queues that are on the 
output list for the image. If you accept a rejected image, confirm that you want this image 
sent.  

If you ignore the warning and acquire images with no output selected, use the Resend 
function to send those images to an output. The system saves all Acquired Images on the 
Acquisition Workstation hard drive regardless of the output selection. The system 
reclaims space in the Image spool only after the Image is successfully sent to all of its 
output destinations. See Automatic Reclamation of Hard Drive Space on page 83 for details. 
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4.13.2 Patient View Screen with Thumbnails 
After the Image is accepted, a thumbnail view of the Image replaces the icon on the 
Patient View screen, and the system transmits the Image to its outputs. Click the 
thumbnail to repreview the image.   

 
Figure 37: Patient View Showing Acquired Image 
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4.13.3 Exposure Taken Using an Incorrect Icon 

4.13.3.1 You Have an Edit View Button 

 
If your Preview screen looks like this in the top right corner and an incorrect view is 
acquired (for example., RCC icon highlighted but patient is positioned for LCC): 

• If you have not accepted the image: 

a. Select the Edit View button. 

b. Select the correct view. 

c. Select OK. A corrected thumbnail replaces the incorrect icon. Add another view 
for the icon that was replaced. 

• If you have accepted the image: 

a. Repreview the image. 

b. Make the view corrections. See Image/Spool Management on page 85 for Repreview 
and Resend directions. 

 

4.13.3.2 You Do Not Have an Edit View Button 

If your Preview screen looks like 
this in the top right corner and an 
incorrect view is acquired (for 
example, RCC icon highlighted 
but patient is positioned for LCC) 
there are two scenarios to 
consider: 

 
Scenario 1 

The mistake is discovered before the image is accepted: 

1. With the Preview screen displayed, click the Clear All Markers button (upper right 
side of screen); the incorrect marker is removed. 

2. Click the correct marker tab. 
3. Click the correct marker. A new marker appears on the preview image. 
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4. Use the table in Changing the View Selection on page 55 as a guide to determine if 
additional changes are required. These changes may include: 

 

• Drag the new marker to the 
bottom of the image. (This is 
done by putting your cursor on 
the new marker, then holding 
the left trackball button down 
while moving the trackball to 
move the new marker to the 
desired area.) 

• Change the Image Laterality 
(middle right side of screen). 

• Change the Patient Orientation 
Column. 

 

5. Click the Accept button after the changes have been made. 
 

 
Note The flipped images do not show on the Acquisition 

Workstation. They may not show on 3rd party systems. 
 

 

 
Note CCL, CV, RL, RM, TAN, CCID - these views all behave the 

same as CC. 

ML, AT, MLOID - these views all behave the same as MLO. 
LMO, SIO - these views all behave the same as LM. 

Scenario 2 

The mistake is discovered after an image once is accepted: 

If the error is not corrected before you Accept the image, the system sends the incorrect 
image to the chosen outputs.  

1. Corrections need to be made at the outputs before you resend the corrected image. 
• Printer—Collect incorrectly printed images and discard. 
• PACS—Contact your PACS administrator to delete the incorrectly marked study. 

2. Corrections must be made in Image (or Spool) Management. 
3. Select Admin>Image (or Spool) Management. 

a. Search for the patient. 

b. Click the thumbnail of the image that needs to be corrected. 

4. Repreview the image to make the corrections. 

a. Click the Repreview tab then the Repreview button. 

b. Make the corrections as previously indicated in Scenario 1. 
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c. Click the Save button. This creates an additional thumbnail showing the corrected 
image. 

5. Click the Resend tab. 

a. De-select the image that you have corrected. 

b. Click the last thumbnail (corrected image), along with any other images that need 
to be resent. 

c. Click the Resend selected image(s) button. 

d. Go to Outputs, and select the correct outputs. 

e. Click the Resend button. 

f. Click the OK button in the Resend Confirmation dialog box. 

6. Click the Close button (bottom right hand corner). 
7. A manager can delete the incorrect image. See Delete Image Function on page 116. 

 

 
Note If there is any doubt of the accuracy of the corrected images, 

repeat the image. 
 

 

 
Note The correction may only be made if the procedure is still on 

the Acquisition Workstation. 
 

 

 
Note Be sure the incorrect images are still on the Acquisition 

Workstation before you delete them from the PACS. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.13.3.3 Changing the View Selection 

Table 5: Incorrect View Selection Changes 
The view 

you wanted 
View icon 

chosen in error 
Change 

Marker to: 
Drag Image 

Laterality 
Patient Orientation 

Column 
RCC RMLO RCC no no change no change 

RLM RCC bottom no change H 
RFB RCC bottom no change R 
LCC RCC bottom R no change 
LMLO RCC bottom R H 
LLM RCC no R no change 
LFB RCC no R L 
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Table 5: Incorrect View Selection Changes 
The view 

you wanted 
View icon 

chosen in error 
Change 

Marker to: 
Drag Image 

Laterality 
Patient Orientation 

Column 
RMLO RCC RMLO no no change no change 

RLM RMLO bottom no change H 
RFB RMLO bottom no change R 
LCC RMLO bottom R no change 
LMLO RMLO bottom R H 
LLM RMLO no R no change 
LFB RMLO no R L 

 

 

RML RLM RML bottom no change H 

 

RLM RCC RLM bottom no change R 
RMLO RLM bottom no change H 
RFB RLM no no change no change 
LCC RLM no R L 
LMLO RLM no R no change 
LLM RLM bottom R H 
LFB RLM bottom R R 
RML RLM bottom no change H 

 

RFB RCC RFB bottom no change R 
RMLO RFB bottom no change H 
RLM RFB no no change no change 
LCC RFB no R L 
LMLO RFB no R no change 
LLM RFB bottom R H 
LFB RFB bottom R no change 

 

 

LCC LMLO LCC no no change no change 
LLM LCC bottom no change H 
LFB LCC bottom no change L 
RCC LCC bottom L no change 
RMLO LCC bottom L H 
RLM LCC no L no change 
RFB LCC no L R 
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Table 5: Incorrect View Selection Changes 
The view 

you wanted 
View icon 

chosen in error 
Change 

Marker to: 
Drag Image 

Laterality 
Patient Orientation 

Column 

 

LMLO LCC LMLO no no change no change 
LLM LMLO bottom no change H 
LFB LMLO bottom no change L 
RCC LMLO bottom L no change 
RMLO LMLO bottom L H 
RLM LMLO no L no change 
RFB LMLO no L R 

 

LML LLM LML bottom no change H 

 

LLM LCC LLM bottom no change L 
LMLO LLM bottom no change H 
LFB LLM no no change no change 
RCC LLM no L R 
RMLO LLM no L no change 
RLM LLM bottom L H 
RFB LLM bottom L L 
LML LLM bottom no H 

 

LFB LCC LFB bottom no change L 
LMLO LFB bottom no change H 
LLM LFB no no change no change 
RCC LFB no L R 
RMLO LFB no L no change 
RLM LFB bottom L H 
RFB LFB bottom L no change 
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4.13.4 Close a Procedure  
 

4.13.4.1 The Close Procedure Button 

 
Figure 38: Patient View Screen’s Close Procedure button 

1. Click the Close Procedure button or press the Close Exam key on the keyboard when 
you have finished. The Procedure remains open until you specifically close it. The 
Patient View screen’s Close Procedure button allows you to end the Procedure any 
time. 

 
Figure 39: A Finished Standard Screening Procedure 

2. If the Procedure is not finished, a dialog box appears. Select Yes to close. The Select a 
Patient screen displays. 

 

4.13.4.2 Close a Procedure with MPPS Enabled 

An optional feature is available for sites with an MPPS Service Class Provider. When this 
feature is installed, you have three buttons to use to close a procedure: 

• Complete button: closes the active procedure and its status is labeled completed. 
• Pend button: closes the active procedure and its status is labeled in progress. 
• Discontinue button: closes the active procedure and its status is labeled discontinued. 

Discontinuing a procedure requires a reason. 
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4.14 Additional Actions on the Patient View Screen 

 
Figure 40: Patient Views Screen with Icon(s) for Scheduled Views 

 

Figure Legend 

1. Add View 

2. Add or Edit a Procedure 

3. Output selection drop-down list 
 

 
 

4.14.1 Add a View to the Procedure 
1. Click Add View. See the figure Patient Views Screen with Icon(s) for Scheduled Views on 

page 59, Item 1.   
2. In the dialog box, select an additional View(s) from the list of Standard 

Mammography Views. You can add multiple views by holding the Control key down 
while clicking. 

3. Click OK to continue. The new View Icon(s) appears with the other views. 
4. Select the new view before acquiring the image. 

 

4.14.2 Remove Unexposed Views Button 
Unused views or procedures are automatically reclaimed, or can be deleted manually 
with the Remove Unexposed Views button. When you click the button you need to select 
All or Selected to indicate which views are to be deleted. 
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4.14.3 Edit Patients and Procedures 

4.14.3.1 Edit Patient Data 

If information about the Patient has changed and needs to be edited: 
 

 
Note This procedure only changes the patient information of 

images in the study not yet taken. Acquired images will 
have to be resent using Image Management and Resend 
after the information is edited. See Image/Spool Management 
on page 85. 

Do not edit patient information if using a Modality Worklist. 
Work with the HIS/RIS administrator to resolve incorrect 
patient information. See Image/Spool Management on page 85. 

1. Click Edit in the Patient Box. 
2. Select the field(s) with incorrect or missing information and make changes to the 

field(s). Use the Tab key or the trackball to move through the fields. 
3. Click Accept. The dialog box closes and the main screen updates with the new 

information. 
 

 
Note The Clear button clears last name, first name, DOB, and age. 

4. Verify that the correct changes appear in the screen before acquiring a new image. 
 

4.14.3.2 Add a New Procedure to an Existing Patient 

1. Recall the existing Patient. 
2. Click New in the Procedure box, and click Yes to Creating a New Procedure will close 

the current Procedure. The New Procedure dialog box appears. 
3. Click the Accession Number field. Enter a new Accession Number. 

 

 
Note The Clear button clears the Accession number so you can 

re-enter it. 

4. Select the Procedure Description from the drop-down list(s). 
5. Click Accept and then click Close in the Patient Pane to close this screen.  

 

 
Note If the Patient already has more than one Procedure, you can 

add a new one directly from the Select a Procedure search 
screen. Otherwise, when you select the Patient, the 
scheduled Patient Procedure opens and you must close the 
Procedure before you can add the new Procedure. 
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4.14.3.3 Add a New Procedure to an Open Patient 

You can have multiple Procedures open at the same time. This allows you to compare 
other images to a new image. To add a new procedure when you want the current 
procedure to remain open:  

1. Click Add in the Procedure Box. The New Procedure dialog box appears. 
2. Select the Procedure Description from the drop-down list. 
3. Click Accept. A new Procedure tab appears on the Patient View screen above the 

View icons and you can work with either Procedure. 

 
Figure 41: Results of Adding Another Procedure 

 
 

 
Note This new procedure uses the same Accession Number as the 

currently open procedure. Use the New button if this is not 
your intention. If your facility requires different accession 
numbers for different procedures, you need to use the New 
button. See Add a New Procedure to an Existing Patient on page 
60. It is not possible to change the Accession Number if you 
use the Add button. 
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Figure 42: Selecting Two Procedures in the Choose a Procedure Screen 

The images can be taken now or later. If taken later, the two Procedures are treated as 
separate Procedures in the Choose a Procedure screen. They can both be opened as one by 
pressing and holding the Ctrl key and clicking each one. Then release the Ctrl key and 
click Select. 

 

4.14.3.4 Changing Patient Information After Accepting an Image 

Once an image has been accepted, it is immediately sent to the selected outputs. If any 
change to the accompanying information is needed, it must be reviewed, saved, and 
resent as an additional record and the previous record deleted. 

Delete the incorrect image from the following outputs:  

• Printer: Collect the incorrect printed images and discard them. 
• DRW: Contact the Diagnostic Review Workstation manager to delete the incorrect 

image(s). 
• PACS: Contact the PACS administrator and alert them to delete the incorrect study or 

advise another corrective measure. 
To correct the information at the Acquisition Workstation: 

1. At the Acquisition Workstation, click the Local Exams tab, and then search using the 
first letters of the last name. 

2. When the patient procedure displays on the screen, click Edit in the Patient Pane. 
3. Change the incorrect patient information. 
4. Click the Accept button. 
5. If the Accession Number is also incorrect, click Edit in the Procedure Pane and make 

the correction. 
6. Click the Close Procedure button. 
7. Select Admin>Image Mgt. 
8. Search for the patient using the first letters of the last name. 
9. Click the Repreview tab. 
10. Click the first thumbnail. 
11. Click the Repreview button. The preview image appears. 
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12. Click the Save button. 
13. Repeat Steps 10 to 12 for the rest of the images in the procedure. There should now be 

eight thumbnails (assuming there were four in the original procedure). 
14. Click the last four thumbnails (the corrected views). 
15. Click Resend to all required outputs. 
16. After you confirm that the four images have been resent, you may want to go back 

into Spool Management and delete the four images that are labeled incorrectly. (You 
have to be signed in at the manager level to do this.) 

 

4.14.4 Non-Imaging Mode Button 

 
Figure 43: Non-Imaging Mode Button 

When you click the Non-Imaging Mode button, the Non-Image dialog box appears. 

1. Click OK. The dialog box closes and the Non-Imaging Mode screen appears. 

 
Figure 44: Non-Imaging Mode Screen 

2. Follow the directions in the QC Manual or Service Manual to use the window. 
3. Click End Non-Imaging Mode when finished. 
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Non-Imaging mode is available to all users, but is unavailable when a patient is selected. 
Non-Imaging mode deactivates the Image Receptor and lets an x-ray prep/expose cycle 
occur while overriding the patient selection and image acquisition sequences. 

The medical physicist can use this mode during QC tests to measure the x-ray tube 
performance without having to wait for images. 
 

 

 
Caution: Protect the Image Receptor from excessive radiation by 

covering it with lead while using the Non-imaging mode. 
 

    
 

4.14.5 Simulate Capture Button 
This function is for use by service personnel only. 

 

4.14.6 Review Button 
The Review button (see figure Patient View Showing Acquired Image on page 52, Item 1) is 
used for Reject /Unreject. Select the thumbnail to review an image. 
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4.15 Clinical Procedures 
This section provides a suggested Sequence of Operation to acquire Patient Images, but it 
is not intended as a substitute for conventional clinical training and methodology. 

The following three sections provide flowcharts for typical clinical procedures. 
 

4.15.1 Manual Mode 
In the Manual mode, you set all the Techniques. The defaults appear when you choose the 
View, and then you make any necessary adjustment for the individual exposure.  
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4.15.2 TEC Mode 
A second mode available to you is the Tissue Exposure Control (TEC) Mode. It is an 
enhanced Manual Exposure Control mode. 
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4.15.3 AEC Mode 
The third mode available to the technologist is the Automatic Exposure Mode (AEC). 
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4.16 Performing a Screening Procedure 
The Selenia is capable of performing routine screening, diagnostic studies, magnification 
studies, and localization procedures. Each of these procedures requires some different 
accessories, but all are performed in the same general sequence of steps. The procedure 
for selecting the patient and view for a Magnification or Spot procedure is the same as for 
a Standard Screening. A Localization procedure has additional steps (see Performing a 
Localization Procedure on page 71). 

 

4.16.1 Select Patient, Procedure, Output, and Exposure Techniques 
At the Acquisition Workstation: 

1. Select a Patient from the Worklist or local database, or add a new one. 
• If your installation uses Patient or Procedure ID bar codes, use the bar code 

scanner to scan patient or procedure (accession) records in both the modality 
worklist and the local database. 

• If your installation does not use bar codes, search the modality worklist. 
• If your installation does not use a network, search the local database records. 
• If the patient is not in the local database, enter patient data using the keyboard. 

2. Identify the required Procedure(s). 
• When working with implants, the beginning procedures are the same as a 

screening except select Screening Mammogram w/Implants procedure in New 
Procedure dialog box. 

3. Select the Output Destination(s). 
 

 
Note If using the CR-RW drive as an output, see CD-RW Drive. 

4. Select the first View. 
5. Set the Exposure Mode and Techniques. 
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4.16.2 Set Up the Gantry 
 

 Warning: C-arm movement is motorized. 
 

1. Install the compression paddle for the procedure and any other necessary accessories. 
2. Set the C-arm height and rotation angle. 

 

 
Note To help with patient positioning, the system memorizes 

oblique C-arm angles. After making an oblique exposure, 
the C-arm angle stores in memory. When you rotate the 
C-arm for the next exposure, the system automatically 
pauses the C-arm at the opposite oblique angle. This is true 
for the C-arm Rotation switches, and the Gantry Rotation 
switches if equipped. You may then rotate the C-arm to an 
angle other than the memorized oblique angle to best 
accomplish breast positioning. 

3. Ensure the light field illuminates the correct area for the installed accessories. 
 

4.16.3 Position the Patient 
1. Use the C-arm height controls to raise or lower the breast platform to accommodate 

each patient. Do not use any heat source (for example, heating pad) on the image 
receptor. 

2. Use the C-arm Rotation-Release controls to move the tubehead to the required clinical 
projection angle. Displays on the Gantry show the current angle of the C-arm. 

3. Move the patient up to the C-arm. 
4. Position the patient as required. 
5. Put the arm or hand of the patient on the Patient Handle or at the side of the patient. 

Inform the patient of the locations of all push button controls and give instructions to 
avoid contact with any controls. 

 

 Warning: Be aware of the position of the patient’s hands and 
arms relative to the C-arm controls. 

 

6. Compress the breast. 
• Use the footswitch controls to provide hands-free compression control and C-arm 

height adjustment. 
• Use the light field lamp as necessary to visualize the x-ray field. Position the 

patient’s breast within the illuminated field to ensure total coverage.  
• Apply compression slowly. Use the handwheels to make final compression 

adjustments. 
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4.16.4 Acquire the Image and Complete the Procedure 
1. Confirm x-ray equipment parameters and Image Acquisition settings. 

• For full implant views, either AEC (Auto Filter) or Manual Exposure Modes may 
be used. See Method One—Imaging Patients with Implants Away From the Nipple on 
page 6 and Method Two—Imaging Patients with Implants Near the Nipple on page 8. 

• For implant displaced views use AEC and manual placement of the AEC sensor. 
See Method Four—Imaging Implant Displaced Views on page 9. 

2. The system is Ready for exposure when:   
• The screen has no "X" across the radiation symbol.  
• The generator status says Ready.  
If the system does not enter a Ready status in 60 seconds, verify that the accessories 
are correctly installed and the paddle is firmly locked into place. 

 

 Warning: Always follow the safety precautions for x-ray 
exposures. 

 

3. Press and hold the X-ray buttons for the entire exposure. 
The Radiation icon on the screen changes from gray to white during this time and the 
x-ray Indicators by the buttons on the keypads glow yellow.   

4. Release the patient. 
• If the compression release is set to manual or you are using a localization paddle, 

raise the compression device. 
• If the automatic release feature is set, the compression device automatically rises 

after the exposure. 
 

 Warning: Do not move the C-arm while the system retrieves 
the image. 

 

5. Preview the image. Observe the Exposure Index to ensure the exposure is correct. 
6. If required, use the Window/Level tool or other Preview options including Image 

Comments—all available at any time while the Preview screen is active. 
7. Accept or Reject the image. 
8. Perform the Acquisition cycle as many times as required for the requested 

Procedure(s). 
9. If necessary, add an additional view or procedure. 
10. Ensure the patient has safely moved away from the unit when you have taken all the 

Views. 
11. Close the Procedure. 
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4.17 Working with Specimens 
Follow standard procedure with the following considerations: 

• Use a Magnification Stand if desired. 
• Use a Spot Paddle. 
• Bring the specimen as close as possible to the chest wall edge of the detector or stand. 
• Use Manual Exposure Mode. 
Note that you can use Admin>Image Management>Resend to resend to a printer if you 
need a second image for pathology. 

 

 
Note You can use the manual collimation button on the tubehead 

to expose the specimen only. This does not reduce the size of 
the image, but does mask out all unnecessary space. The 
minimum cropped size of a Selenia image is 18 x 24 cm. You 
cannot further reduce the image size for specimens. 

 

 
 

4.18 Performing a Localization Procedure 
 

 Warning: The system is configured to disable Automatic 
Compression Release when a Localization paddle is 
installed. If you use a paddle other than a 
Localization paddle during this procedure, you must 
disable Automatic Compression Release. On the 
Main Menu, click Edit>Standard Setup and change 
the Compression Release option from Automatic to 
Manual. Return this option to Automatic when the 
procedure is complete. 

 

 
 

4.18.1 How to Use the Standard Crosshair Device 
The Localization procedure has additional steps not needed in other clinical procedures. 

1. Follow the standard screening procedures to Step 3, Set Up the Gantry on page 69. 
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2. Install the Crosshair Device. 
3. Change the Compression Release setting to 

Manual if set on Automatic. 

a. Select Edit>Standard Setup. 

b. Select Manual in the Compression Release 
field. Wait a few seconds before closing the 
window for the change to take effect. 

c. Click Close.  
Figure 45: Rotate the Crosshair Device 
Out of the X-ray Field 

4. Rotate the Crosshair Device out of the x-ray field before taking the scout image. 
 

 
Note Auto AEC is not available with localization paddles. Choose 

AEC position 2 or 3. 

5. Take the scout image. 
6. Click Zoom/Pan in the Preview window to see a magnification using the entire 

screen. 
7. Pan the image by dragging with the right trackball button. 
8. Click Crosshair and then click on the area of interest to display the crosshair lines. 
9. Click Zoom/Pan button off to see where the crosshairs intersect with the 

alpha-numerics on the screen. This determines the horizontal and vertical position of 
the lesion. 

10. Move the crosshair device into the field. 
11. Turn on the light field lamp. 
12. Adjust the crosshair knobs to place the crosshair shadows at the appropriate reference 

labels on the localization paddle. The intersection of the crosshair shadows on the skin 
indicates the position of the lesion on the scout image. 

13. Note the position on the breast. 
14. Move the crosshairs out of the x-ray field. 
15. Continue with the Localization Procedure, changing paddles as required. 
16. Upon completion of the procedure, change the Compression Release back to 

automatic if this is the site default. 

a. Select Edit>Standard Setup. 

b. Select Automatic in the Compression Release field. Wait a few seconds before 
closing the window for the change to take effect. 

c. Click Close. 

17. Use Standard Screening steps for the Procedure. See Performing a Screening Procedure 
on page 68. 
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4.18.2 How to Use the Magnification Crosshair Device 
Follow the instructions in How to Use the Standard Crosshair Device on page 71 except: 

1. Attach the Magnification stand. 
2. Attach the Magnification Crosshair Device to the tubehead. 
3. Check to make sure the Grid Out and Small Focal Spot are selected. 
4. Dial the Crosshairs out of the way before you take the scout shot. 
5. Remove the crosshair device after the needle placement when you are ready to 

continue with the procedure. 
 

4.19 Accepting and Storing the Image 
Use the Preview screen to: 

1. Inspect for good positioning and proper exposure level. 
2. Accept or Reject the image. 

• If it is acceptable, select Accept and wait for the image to appear as a thumbnail 
on the Patient Procedure screen. 

• If the image has problems (for example, under-exposure or movement), enter 
Reject and the reason it is unacceptable. Repeat the exposure. 

• Note the displayed actual exposure value. If a minimum exposure (250) is not 
achieved, the image should be rejected. 

Accepting an image transfers it to the selected Output device(s). 

Rejecting an image stores the image in the Reject Bin, and does not send it to the Output 
destination. All images, Rejected as well as Accepted, appear on the Procedure’s Review 
of images. All Rejected Images are stored in a log with their reasons for rejection.   

For additional information on accepting and storing images, see Accept Button Details on 
page 48. 

 

4.20 Optional Workflow Operations 
In addition to the workflows described above, optional operations are available to: 

• Open multiple Procedures within a Patient. See Add a New Procedure to an Existing 
Patient on page 60: 

• Search by either Patient Name or ID to Open a new Procedure for an existing patient. 
See Add a New Procedure to an Open Patient on page 61. 

• Search by either Patient Name or ID to Recall an open Procedure to continue that 
Procedure. See Choose a Procedure on page 36. 

• Resend previously acquired Images. See Image/Spool Management on page 85. 
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4.21 Main Menu Functions 
Main Menu functions provide the technologist with easy access to non-routine 
Acquisition Workstation functions. They are always available while the Acquisition 
Workstation application is running unless a dialog box or Procedure is open. 

This section describes additional details about the menus in the order they appear on the 
screen. If a menu item is not listed, there are no additional hints or descriptions about the 
item available beyond the information in the User Guide. 

 

4.21.1 Main Menu with No Selected Patient 
The table below lists the Main Menu functions for the technologist when a Patient 
Procedure is not selected. Once a Procedure is open, the Main Menu functions are not 
available. 

Table 6: Main Menu Functions with No Procedure Chosen 
Menu Function Tech 
File Exit 
Edit Standard Setup 

View Order Editor 
User Setup 
Outputs 

Admin Image Management 
Protect Patients 
Manage Queues 
Eject 
Import 
Retrieve Priors 
PPS Status* 
Calibrate 
Test Patterns 
DR Device Control 
Available Disk Space 

Info About the Acquisition Workstation 

*This only appears when the MPPS Service is installed. 
 

 
 

4.21.2 File Menu>Exit 
The Exit function provides options for exiting the system if a Patient/Procedure is not 
displayed. If a Patient/Procedure is open, a dialog box informs you that you cannot Exit 
while a Patient/Procedure is open. See How to Log Out or Shut Down on page 24. 
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4.22 Edit Menu 

 
Figure 46: Edit Menu 

 

 
 

4.22.1 Standard Setup Screens 
On the Main Menu, click Edit>Standard Setup to display a list of startup defaults. The 
table below lists available options. Hints appear in the lower pane as the cursor moves 
over the different choices. 

Table 7: Setup Choices 
Choice Range of choices 

Pre-compression Force 10 - 100% 
Full Compression Force 10 - 100% 
Compression Force Units Pounds (lb) or Newtons (N) 
Compression Release Mode Automatic or Manual 
Compression Force Mode Pre, Full, or Dual 
Collimator Automatic or Manual 
Default Exposure Mode  Auto-Time, Auto-kV, Auto-Filter, TEC, or Manual 
Default Magnification Mode Auto-Time, Auto-kV, TEC, or Manual 
Set Technique Defaults See Set Technique Defaults Screen on page 75. 

 

 
 

4.22.2 Set Technique Defaults Screen 
The last button on the Standard Setup screen, Set Technique Defaults, displays the 
Technique Default Setup screen. Select Manual Exposure Mode to start. Remember to set 
the Magnification modes. Each possible default must be set up. 

Table 8: Set Technique Default Choices 
Mode Choices 

Manual (and Mag) Filter, kVp, mAs, mAs Table, Focal Spot (Large or Small) 
Auto-Time (and Mag) Filter, kVp, mAs Table, Focal Spot, AEC Region position, and 

Density 
Auto-kV (and Mag) Filter not selectable (default is Mo for Moly Tube, Rh for 

Tungsten), mAs Table, Focal Spot, AEC Region position, and 
Density setting 

Auto-Filter (and 
Mag) 

mAs Table, AEC Region position, and Density setting 

TEC (and Mag) Filter, mAs Table, Focal Spot, and Breast Density (Fatty, Normal 
or Dense) 
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4.22.3 View Order Editor 

 
Figure 47: View Order Editor 

To set up your individual view order defaults, drag the View icons to change their order. 
Select the procedure from the drop-down list. You may set view orders for each 
Procedure. Click Close. Your View Order preferences are saved and load each time you 
log in. 

 

4.22.4 User Setup—Add or Edit a User 
Click Edit>User Setup. The Edit Users dialog box appears. 

A user can only be added or deleted at the same 
or lower level as the user signed in. Example: 

• Mgr can add or delete a mgr or tech user. 
• Tech can add or delete only a tech user, 

not a mgr. 

 
Figure 48: Edit Users Dialog Box 
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4.22.4.1 Add a New User 

To add a new user: 
1. Click New. 
2. Enter the requested information in the fields. 
3. Assign a password. The password must contain at least 6 

characters.  
4. Click Accept to add the user, or Cancel to leave without 

adding the user. 
• The user name appears on the printed images. 
• The initials appear on the electronic image. 

 
Figure 49: Add a New User 

 

    
 

4.22.4.2 Edit Your Profile 

To edit your initials or password: 
1. Select your name from the list. 
2. Click Edit. The Edit Profiles for <name> 

appears. 
3. Change the Initials if necessary. 
4. Enter your old password. 
5. Enter a new password. The password must 

contain at least 6 characters. 
6. Reenter the new password to confirm it. 
7. Click Accept to make the change. 

 
Figure 50: Edit User Profile 

 

 
Note You have to enter the password to change the initials. 

 

 
 

4.22.4.3 Delete a User 

To delete a user: 

1. Select a User in the Edit Users dialog box to delete. 
2. Click Delete. 
3. Confirm the deletion in the Delete? dialog box by clicking Yes, or cancel the deletion 

by clicking No. 
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4.22.5 Set Up Outputs 
An Output is a pre-defined list of one or more physical output devices, which determines 
where to send images from the Acquisition Workstation. Outputs are initially created 
during the installation process. The Output name is used to identify which devices are 
included in the Output group. Physical devices (for example, printer archives, diagnostic 
review workstations, etc.) are supported via Named Virtual Devices. These become the 
output destinations of the system and can be grouped together or used individually. 

The Edit Outputs function adds or removes Outputs. A list of currently available choices 
appears in the dialog box and you can group destination devices into an output group, 
add new groups, delete, copy, or edit current ones. The external CD-RW drive and any 
network connections are setup at installation. They can be combined into additional 
group outputs. 

Outputs are defined using the Edit Outputs Menu. This option enables you to: 

• Select output destination(s) and add/subtract them from the output’s device list. 
• Select devices to be associated with each output destination. 
• Save the output under a recognizable name. 
• Create a new output list using an existing output list. 
• Delete an output list. 
In the Edit Outputs function, the lists of configured possible output destinations are 
sorted by device name: 

• Archive = PACS and local storage devices 
• CDRW = CD-RW 
• Physician Display = diagnostic review workstation, technician review workstation, 

CAD 
• Laser Camera = Printer 
Other characteristics of output lists are: 

• A single named virtual device that appears in multiple output lists has the same 
configuration in all those lists. 

• At least one output list is named "No Outputs" and contains no devices. 
• Named virtual devices appear in the Edit Outputs tool’s destination list when the 

service engineer configures the device. An output for the virtual device appears in the 
output list when the device is added using the Edit Outputs function. 

 

 
Note Only Accepted Images are sent to the selected list of outputs. 

Rejected Images are sent to their own list of output devices 
and must be removed from the system after being reviewed. 
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4.22.5.1 Add a New Output Group 

1. Select Edit > Outputs, and then click New to add a new output. 
2. In the Output Name dialog box, enter the name you want to use for this output (for 

example, DV8900 Printer). 
3. Click OK. The new name shows up in the Edit Outputs dialog box. 

 
Figure 51: New Name in Edit Outputs Dialog Box 

4. Select the new name (for example, DV8900 Printer) in the Edit Outputs dialog box, 
and click Edit. 
The Edit Output: <device name> dialog box appears, with tabs for the four types of 
outputs. The device names currently selected are listed in the right column. 

5. Click the tab of the device type you need to add. The driver(s) for that type of output 
are listed. 
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Figure 52: Adding Devices 

6. Select the device you want to use. 
7. Click Add in the middle of the box. The device name appears in the right column, 

Devices currently selected. 
8. If you want to add an additional output, click the device tab for it. 
9. Click the additional device you want to add. 
10. Click Add to move it to the right column. You can add many devices to a group. 
11. Click Accept to close the Edit Output: <device name> dialog box. The new group 

name shows up on the Edit Outputs dialog box. 
12. Click OK to close the Edit Outputs dialog box. 

 

4.22.5.2 Edit Outputs and Make New Groups 

To recombine devices or delete a device from a group: 

1. Select Edit > Outputs. 
2. Click an Output name(s) that you want to change or recombine. 
3. Click Copy. A dialog box appears. 
4. Enter the new Output name you want to use for this Output (for example, 

LaserPrinter3). 
5. Click OK. The new name shows up in the Edit Outputs dialog box. 
6. Select the new name, in this case LaserPrinter3, in the Edit Outputs dialog box. 
7. Click Edit. The Edit Output: <device name> dialog box appears, with tabs for the four 

types of outputs. Devices currently part of the group are listed in the right column. 
8. Click the tab of the device type to add (for example, laser_cameras). A list of the 

driver(s) for that type of device appears. 
9. Select the device you want to use. 
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10. Click the Add button in the middle of the box. The device name appears in the right 
column, Devices Currently Selected. 

11. If you want to add an additional device, click the tab for it (for example, cdrw for a 
CD-RW drive). 

12. Click the additional device you want to add. 
13. Click Add to move it to the right column. 
14. Click the name of any output in the Devices Currently selected column that you do not 

want in the group and click Remove Item. 
15. Click Accept to close the Edit Output: <device name> dialog box. 
16. Click OK to close the Edit Outputs dialog box. 

 

4.22.5.3 Delete Outputs 

To delete an output group name that is no longer needed: 

1. Select Edit > Outputs. 
2. Click the output name(s) that you want to delete. 
3. Click Delete. The Delete output? dialog box appears. 
4. Click Yes in the Delete Output? dialog box. The dialog box closes and the output 

name is removed from the Currently available outputs list. 
 

4.22.5.4 Output Queues 

Actual transmission to a given output device is handled through output queues 
associated with the device. The following conditions apply to output queues: 

• Output queue states are held through shut down cycles. 
• Output queues are automatically restarted in the same state as at shutdown. 
An Admin Menu function (see Manage Queues on page 89) allows you to: 

• Cancel jobs from queues (not including active jobs). 
• View job status within queues. 
• Resend "stopped" jobs. Note that images for problem jobs are not reclaimed. 
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4.22.5.5 Using the New Output in the Patient View Window 

 
Figure 53: Choose Output 

1. Click the Outputs down arrow. 
2. Select the new name (for example, LaserPrinter2). A Setup output devices dialog box 

appears informing you that you are changing to the output <name> and listing the 
virtual device name(s) in the output. 

3. Click OK to close the Setup output devices dialog box. 
4. Click OK to close the Setup Warning dialog box. 
The "no outputs" option is used by service when they do not need an output. If you choose 
this option, none of the images you acquire are sent to any other devices. 

 

4.22.6 Data Storage (Using Outputs) 
The Selenia data storage system is comprised of the following subsystem components: 

• Acquisition Workstation hard drive (automatic save)—for acquisition, temporary 
storage, and QA display of the breast images 

• CD-RW—for temporary storage of images on removable storage media   
The Selenia System can interface with these components: 

• Diagnostic Review Workstation—for display of diagnostic quality images 
• Film Printer—for printing on high-resolution films 
• Network Storage—for storing data, archiving images 

  



Selenia User Companion 
Chapter 4—The User Interface 

 
 
 
 
 
 

 
MAN-03271 Revision 003  83 
 
 

The Selenia System, when connected to a network, can store data on many systems and 
can output to many others. These integrated systems are user selectable and location 
specific. 

If you do not have a connection to a PACS system, you must send the patient information 
to an approved film printer. 

 

4.22.6.1 Hard Drive 

The Acquisition Workstation computer’s hard drive automatically stores the Acquired 
Images. Select the Main Menu item Admin>Available Disk Space to display the available 
storage space remaining, in units of images, on the system. The capacity of the hard drive, 
about 50 Images per Gb, depends on the size of the images. A 24 x 29 cm image uses more 
storage space than an 18 x 24 cm image, so the number of available images is an estimate. 

 

4.22.6.2 Automatic Reclamation of Hard Drive Space 

The system automatically reclaims hard disk storage space for new procedures. 
Reclaiming is a process of deleting existing patient files from the Acquisition Workstation 
hard drive to make room for new patient information. The image reclaimer deletes images 
from the system when a number of images have accumulated on the system. Once 
reclamation of images begins, images continue to be reclaimed until the number of images 
on the system reaches a set number. 

 

 
Note Your service representative can configure your system to 

auto delete rejected images from the Reject Bin. When auto 
delete is not configured, rejected images must be deleted 
manually. 

Some images are not deleted: 

• No patients are deleted if they have any images queued to an output device. 
• No images are deleted for protected patients.  
• No images queued up on an output device are deleted. 
• No images that are not successfully committed to an archive device are deleted. 

 

 
Caution: If the disk does not have enough available space, the 

system does not acquire an image. A message displays the 
capacity of the disk. Delete unneeded images to restore the 
disk space. 

 

This message can appear only after messages alerting you that there are too many 
protected patients or too many images backed up on an output device. This situation can 
be due to a configuration issue that service can correct. 
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4.22.6.3 CD-RW Drive 

A Compact Disc ReWritable (CD-RW) drive, mounted on the underside of the Acquisition 
Workstation, is available for temporary storage of images. If you do not have a PACS 
network connection, you must select an approved film printer as one of the outputs for 
patient images.  

1. To use the CD-RW drive as an output, in the Output box of the Patient View window, 
select an output that includes the CD-RW. A Setup Output Devices dialog box 
appears, informing you that you have selected a new setup <name> and giving you the 
virtual device name for the CD-RW.  

2. Open the drive drawer by pressing the Eject button on the drive. 
3. Write the patient name, ID, and date on the envelope and/or CD. Insert the approved 

CD-R disk in the drive prior to starting a procedure. 
4. Select the CD-RW as an output, or part of an output group. Acquired images are now 

sent to the CD as well as to any other output in the group (if any). 
5. After the last view is accepted, it takes a few minutes to finish writing the images to 

the CD (longer for 24 x 30 cm images). 
• Observe the Jobs in Queue message in the Outputs pane to tell when all the 

images are done. 
• You can use Admin>Manage Queues to see what is still in the Queues. 

6. After the last view is sent, use Admin>Eject to eject the CD. 
Writing images to a CD takes longer than saving or printing them. You can use the Image 
Management>Resend option and write them after the procedure is finished. This has the 
advantage of not slowing down the rest of the procedure while you are waiting for the 
program to write to the CD during Image Acquisition. 

To see which patients/views are on a CD, use Admin>Import. 

The CD-RW drive is also available for importing images from other Selenias recorded on a 
CD. Use the Admin>Import directions for Importing Images.  

 

4.22.6.4 Change the Disk in the CD-RW Drive 

When the disk is near capacity, a system message tells you that the disk is running out of 
room. 

To change the CD: 

1. Click Eject on the alert message dialog box and the CD-RW drive drawer opens.   
2. Remove the full CD and insert a labeled blank one. 
3. Close the drawer. Label the full CD and store it in accordance with local requirements. 
4. Click Continue to save the remaining Images. 
If you click Cancel and do not change the CD, the system generates an Alarm and does 
not archive the current Image on the CD. It is saved on the hard drive and you can Resend 
it from the Image Management function. 
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4.22.6.5 Film Printer 

The system can send the Image to an optional high-resolution DICOM film printer. 
Details on the function of the printer depend on the printer. The printer configuration (as 
with any new printer) is setup by an authorized service engineer. You must add it to the 
Outputs list.   

 

4.22.6.6 Network Storage 

The system supports retrieval of the archived Images and Procedures. A separate 
diagnostic review workstation can retrieve the Images. Details on the function of these 
outputs depend on your specific configuration.  

 

4.23 Admin Menu 

 
Figure 54: Admin Menu 

 

 
 

4.23.1 Image/Spool Management 
This Admin Menu item allows you to: 

• Query for Patients whose Images are still within the Image spool. 
• Resend selected images in the spool to Output Destination devices. (The system 

resends Images to the selected output exactly as found in the spool.) 
• Repreview an Image to add comments or edit images after the image is accepted, 

which generates a new image file. 
• Confirm DICOM storage commitment. 
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Query details: 

• Entering an incomplete string returns all matches to the string. 
• Queries are not case sensitive. 
• "No entry" or "*" is equivalent to everyone in the Image spool. 
• If too many matches are found, the application requires more specific search criteria. 
• If no matches are found, the message "No Patients matching query" is displayed. 
• When there are Images for the queried Patient(s), the Acquisition Workstation 

displays Patient information in a table. 
When you have selected a patient to manage, an Image Management screen displays. The 
upper right pane displays detailed information about the view when you have selected a 
single view. This information includes the view name, acquisition capture timestamp, 
technologist, comments, and other data. The lower pane displays thumbnails of all the 
images of the selected Patient in the order of acquisition. 

 

4.23.1.1 Using the Resend Options 

 
Figure 55: Image Management Resend Options  

1. Select a thumbnail image to resend. The output selected when the image was acquired 
appears as the default. 

2. If the Output is not correct, select the Output you want from the drop-down list. The 
Output change you make here does not affect the Output selection on the main 
screen. 
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3. If the selected Output has a printer, the following Print Image Processing Options 
appear. Click the option to select or deselect it.  
• Adjust the Contrast and Density for printing. Change by clicking another 

number to increase or decrease.   
• Print True Size (if available at the printer). 
• Apply PCE (the Peripheral Contrast Enhancement Function uses a special 

algorithm to enhance the appearance of the mammograms). 
• Omit Patient Name. 
• Omit Label options. 

4. Click Resend. A dialog box states the number of images resent. 
 

 
Tip: You cannot change any Patient or image object information 

from the Resend function. This includes image, LUT 
modifications and DICOM information such as Patient name 
spelling, ID, comments, etc. The only way to send new 
information is to make a new file using the Repreview 
function, save it, and Resend this new file. 

 

 
 

4.23.1.2 Using the Repreview Option 

 
Figure 56: Repreview Screen 

1. Select one Image thumbnail that you want to review. Use the arrows to scroll when 
more than four images are available. 

2. Click the Repreview tab, then the Repreview button. 
3. The Repreview screen appears with the same tools as you had in the Preview screen. 

If you only want to review the Image, click Cancel when you are done. If you select a 
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FOR PRESENTATION image, you cannot change the markers and ROI is not 
available. 

4. If you want to create a new file to resend, make any required changes to the markers, 
comments, or use the Edit View button and then click Save. 

5. Make any necessary changes to the output selection. When the Send Image to Output 
dialog box displays, click Yes to send the images to the selected output group. 

6. If you are reprinting, make any necessary changes in the Contrast or Density.  
7. Click Save. The Repreview screen closes and the Image Management screen appears 

again. You have created a new copy of the original file. 
 

 
Note Be careful when resending that you send the newly saved 

image. The original is still there as a possible selection. 
 

 
 

4.23.1.3 Correcting Incorrect View Selections with an Edit Button 

One use for the Repreview function is to correct an incorrect view exposure if the error 
was not corrected before clicking Accept. 

1. In the Repreview screen, select the Edit View button. 
2. Select the correct view. 
3. Select OK. The incorrect view is replaced with a corrected one. 
4. Click Save to save the new version with corrected markers and orientation. 
5. Select the Resend tab. Deselect the wrong image and select the last new thumbnail. 
6. Select the correct output and select the Resend button. Click OK in the confirmation 

box and click Close to leave the Image Management function. 
7. Delete the incorrect image sent to the chosen outputs. 

• If the image was printed, collect and discard the incorrect image. 
• If the image was sent to a diagnostic review workstation, log on and delete the 

incorrect image. 
• If the image was sent to the PACS, contact the PACS administrator and have them 

delete the incorrectly marked study. 
• A manager can delete the incorrect image. See Delete Image Function on page 116. 

If your Preview Screen does not have an Edit button and you have accepted the image, see 
You Do Not Have an Edit View Button on page 53. 

 

4.23.1.4 Other Options on the Image Management Screen 

• Query for another Patient by clicking Choose a New Patient. 
• Close the Image Management screen without taking any actions. 
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4.23.2 Protect Patients 
This menu item protects or unprotects Patient’s records on the Acquisition Workstation 
hard drive. The system cannot automatically reclaim Protected records. 

1. Select Admin>Protect Patients. 
2. Search for the Patient you want to protect and select the Patient from the search 

results. 

 
Figure 57: Protecting Patients 

3. Click Protect at the bottom of the screen. A dialog box appears prompting you to 
confirm you want to protect the Patient. Select Yes. 

To Unprotect a Patient: 

1. When you no longer need to protect a Patient, select Admin>Protect Patients. 
2. Select the name and click Unprotect. 
3. Repeat for each patient who no longer needs to be protected. 
4. Click Close to close the dialog box. 

 

 
Note Be sure to Unprotect Patients when you no longer need 

them to avoid filling up the Acquisition Workstation hard 
drive. 
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4.23.3 Manage Queues 
Click Admin>Manage Queues to find problem jobs or locate a particular job in the 
queues.  

Actual transmission to any output is handled through Output Queues. Each connected 
output device is associated with an Output Queue. If a physical device does not accept a 
job or if the job does not complete successfully, the job may be retried or held as a Problem 
Job, depending on the reason for the error. 

A service configurable number of retries are performed before an alarm is generated. A 
service configurable number of retransmission attempts occur after the alarm is 
generated. Once the alarm condition clears, the alarm must be erased to be cleared. 

Jobs may fail because there is either a problem with a specific characteristic of the job (for 
example, configured LUT not available on the physical printer) or because there is a 
general problem with the physical device (for example, device is off-line). In order to keep 
Problem Jobs from clogging an otherwise operational queue with retries, the output 
queues have two levels of priority. The levels are managed automatically and there is no 
direct user interaction. 

You can view the states of the output queue: 

• Waiting—job has not made it to the top of the queue yet. 
• Running—job is active. 
• Sleeping–Error—job has an unresolved alarm that has continued for a configurable 

number of retries (see below). 
• Stopped–Error—job has a non-recoverable alarm and is not being retried. 
• Output queue states are held through shutdown cycles. 
• Output queues are automatically restarted in the same state they were in at 

shutdown. 
 

 
Note Images for problem jobs are not reclaimed until the job is 

removed from the queue. 
 

 
 

4.23.3.1 Job Retry Options 

The Acquisition Workstation supports the following job retry actions. The parameters 
used in the action processing are service configurable; factory defaults are listed below. 

• Number of failed retries before an alarm is posted (default = 3). 
• Initial delay time between retries that occur after the alarm is posted (default = 90 

seconds). 
• Number of failed retries using the initial delay time (default = 10). 
• Final delay time between retries (default = 900 seconds) Note: This feature helps to 

prevent failed jobs from "clogging" the queue. 
• Total number of retries attempted after an alarm has been posted until the job is 

marked "Stopped" (default = 7). Retries are discontinued. 
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4.23.3.2 Available Manage Queues Functions 

You have the following functions (see the numbers to the left of the following figure): 

 
Figure 58: Manage Queues Screen 

Legend 

1. A list of available queues. Different spoolers may have been configured to handle 
different communication services. 

2. Enable or disable a job spooler. 
3. Update the list of queued jobs. 
4. A scrolling list of queued jobs. This list identifies all of the jobs in the queue by: 

• Patient Name 
• Patient ID 
• Study 
• Image 
• Job Status: Running, Waiting, Problem, Sleeping, Stopped 
• Retry Count 
• Device 

5. Selecting an inactive job from the list activates buttons that allow you to: 
• Delete a job from the queue. 
• Resend a job, if the job is in the stopped status. 

You cannot delete currently Active jobs from the queue, and the Delete Job button is not 
active if you select such a job. If a job is stopped, the Resend Stopped Job button becomes 
active. 

You can delete all jobs the system is not currently sending from the queue regardless of 
who originally queued it. 
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4.23.3.3 Using Manage Queues 

Click Admin>Manage Queues to check for problem jobs or locate a particular image in 
the queues. 

 

4.23.3.4 Determine the Status of a Job 

1. Click the queue you want to view in the Devices list. 
• The jobs in that queue are listed in the Queued Jobs list. 
• Their status is in the Job Status column. 
• A status of "sleeping" means a job has been retried several times in a row and is 

currently suspended for an hour or so before retrying.   
2. Click OK when you are finished. 

 

4.23.3.5 Delete (Canceling) a Job 

 Warning: When you select Delete Job, the job is permanently 
deleted. If you did not send the job, resend it to a 
storage device later. 

1. Click the queue you want to manage in the Devices list.  
2. Click the Suspend <name> Spooler button. 
3. Select a job from the Queued Jobs list, or Ctrl+Click to select multiple jobs. Verify the 

job(s) you want to delete are selected correctly. There is no "undo". 
4. Click the Delete From Queue—below the list. 
5. Click OK when you are finished. 

 

4.23.3.6 Resend a Stopped Job 

1. Click the queue you want to manage in the Devices list.  
2. Select a job or jobs labeled “Stopped” from the Queued Jobs list. 
3. Verify the job(s) are selected correctly. 
4. Click the Resend Stopped Job button—below the list. 
5. Click OK when you are finished. 

 

4.23.4 Eject 
 

 
Note The drive drawer only opens from the menu when there is a 

disk in the drive. 

Click Admin>Eject to open the CD-RW drive drawer when there is a disk in the drive. If 
there is no media in the CD-RW drive, clicking Eject in the menu results in a CD-R alert 
window informing you there is no media in the drive. Press the button on the CD-RW 
drive to open the drawer. To close the drive, in either case, press the CD-RW drive button.   
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4.23.5 Import 

 
Figure 59: The Import Dialog Box 

 
 

 
Note Do Not press the Eject button on the drive while the system 

reads from or writes to the disk. It may cause the drive to 
stall. 

Imported images can be reviewed and sent to outputs including store-committing them. 

1. With the CD containing the images to import in the drive, select Admin>Import to 
import a DICOM Image file from a CD. A dialog box appears and the system reads 
the CD in the drive. The Patient’s name displays in the list. 

2. In the dialog box, find the file(s) you wish to import. 
• Clicking on a "+" opens a list of folders and/or files below. 
• Clicking on the empty box selects the file or folder. 
• Click the file name and a check appears in front of all files you have selected. 

Alternately, click a folder to see the list of files in the folder. If you click the box in 
front of the folder, you select all the files in the folder. All checked files are 
imported. 
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Tip: If you have selected a file that you do not want to import, 

click the check mark again to clear it. Clicking on a folder 
selects all subfolders below it. Re-clicking on the folder 
unselects the folder, but does not unselect all the files below 
it. You have to clear each one. 

3. Click Import. A dialog box indicates the progress of the import. 
4. Click Cancel to close the dialog box without importing anything. 

 
Figure 60: Import Progress Dialog Box 

5. The Import Progress dialog box indicates the files imported and whether the import 
is successful or not. 

The imported Patient data is available in the Select a Patient screen. 
 

4.23.6 Retrieve Priors 
All users can view prior images on the Acquisition Workstation if the Images are in the 
Local Database or stored on the PACS system. Find images in the Local Database by 
clicking the Local Exams tab and searching for the patient.  

Images on the PACS need one more step. After the Selenia system retrieves the prior 
images for a patient from the PACS system, select the source if more than one source is 
configured. 

The system imports images into the Acquisition Workstation Local Database. Images 
already on the Acquisition Workstation generate an alarm if you try to overwrite them 
with the PACS version. 
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The rules for handling the For Processing and For Presentation retrieves of the same 
image are: 

• If the image being retrieved is a For Processing image and is already present in its For 
Processing form in the database, you are alerted to the fact that the image is already in 
the database and that the import of that image did not occur. 

• If the image being retrieved is a For Processing image and the For Presentation 
version is already in the database, you are alerted to the fact that the image is already 
in the database and that the import of that image did not occur 

• If the image being retrieved is a For Presentation image and it exists as a For 
Presentation image in the database, you are alerted to the fact that the image is 
already in the database and that the import of that image did not occur. 

• If the image being retrieved is a For Presentation image and the For Processing 
version is already in the database, then discard the data for the For Processing version 
and replace it with the For Presentation version. The log file notes this replacement 
activity. 

• After the import is completed, the patient can be opened using the Completed Exams 
tab and found like any patient captured on the Acquisition Workstation. Any import 
errors show as Alarms. 

To retrieve priors from the PACS system: 

1. Click Admin > Retrieve Priors. The Retrieve Priors screen appears. 
2. Search for the patient name in the Name field or ID in the ID field (wildcards are 

allowed). 
3. After searching the PACS system, a list of all patients meeting the query criteria 

appears (Number 1, in the figure). The progress bar on the lower left (Number 2, in 
the figure) shows that the system is busy searching. 

4. Select the patient name(s) you want to import. Selecting a patient activates the Import 
button. 
• You can choose several patients at once. 
• Clicking a selected patient deselects them. 
• The title bars allow sorting by field. 

5. Click Retrieve and Import (Number 3, in the figure). The PACS system finds the 
images and imports them into the Acquisition Workstation Local Database. A dialog 
box appears and the progress bar indicates the status of the import. 

6. Click OK to close the dialog box. 
7. Click Close to close the Retrieve Priors screen and return to the standard acquisition 

screens while Import operates in the background. 
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Figure 61: Results of the Retrieve Priors Query 

Figure Legend 

1. List of Patients 

2. Import Progress Bar 

3. Retrieve and Import 
Button 

 

After the import is completed, you can show the patient images using the Local Exams tab 
in the same way as any patient image acquired on the Acquisition Workstation. Alarms 
show any import errors. 

If your query resulted in more than 50 records, a system message appears telling you to 
refine your search. 

If there are errors in the results of the query, a system message appears. 
 

 
 

4.23.7 MPPS Status 
An optional feature is available for sites with an MPPS Service Class Provider. When this 
feature is installed, workflow changes with three close procedure button options instead 
of one. Adding a procedure and starting a new procedure also have slightly different 
functionalities. 

 

4.23.8 Test Patterns 
Select Admin>Test Patterns to access the Test Patterns dialog box. Use Test Patterns for 
the Laser Printer Test (make different selections for other uses). Refer to the Quality 
Control Manual for details about the test. Complete instructions are in the User Guide. 

When you send the test pattern to the printer, you get an Image Queues dialog box. To 
see where the image is in the queue, see Manage Queues on page 89. 

If the system has problems with disk space or reclamation warnings, click the Clean Up 
button to clean up any files from previous "test pattern sends" before sending the current 
image.  
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4.23.9 Available Disk Space 
The available storage space remaining is indicated in units of images. This information is 
displayed on the window by selecting Admin>Available Disk Space. The capacity of the 
hard drive, about 50 images per Gb, is dependent on the size of the images. A 24 x 29 cm 
image uses more storage space than an 18 x 24 cm image. 

 

4.24 Info Menu 
The Info menu identifies the Acquisition Workstation software version. The screen 
displays current temperature of the detector and the temperature, date, and time of the 
last calibration. It also provides the maximum temperature the detector has reached and 
date and time this occurred. 
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Chapter 5 
Chapter 5System Hardware Details 

5.1 System Power Controls 

5.1.1 Acquisition Workstation Circuit Breaker 
Location of Circuit Breaker Detailed Description 

 
Figure 62: Acquisition Workstation Circuit Breaker 

The Acquisition Workstation Circuit 
Breaker is found on the back of the 
system behind the shield. The Value 
Console Circuit Breaker (not shown) is 
found on the back of the Console. 
Do not normally turn the circuit 
breaker off. Use the circuit breaker 
only in an emergency, because the UPS 
power is removed and its battery 
begins to discharge. This can result in 
data loss.    
If you use the circuit breaker, wait 
until the UPS does not make a beep to 
turn the circuit breaker back On. The 
system automatically restarts, but the 
UPS might not respond automatically 
and then you must reset it. 
See Uninterruptible Power Supplies 
(UPS) on page 100 for directions.  
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5.1.2 Gantry Circuit Breaker 
Location of Circuit Breaker Detailed Description 

 
Figure 63: Gantry Circuit Breaker 

The Gantry circuit breaker is found at 
the lower right corner of the back 
panel. It provides overload protection 
and removes power from the Gantry 
only. It should be used only to remove 
power for servicing or in an 
emergency.  
Up is On and Down is Off. 
When the circuit breaker is used to 
turn off the Gantry, the system needs 
to be restarted. If the Acquisition 
Workstation is off, restart the system 
normally. 
If a Panel Power dialog box appears 
on the Acquisition Workstation, 
follow the procedure in the User Guide 
to restart the system. 

 

 
 

5.1.3 Uninterruptible Power Supplies (UPS) 
When there is no power to the system, the Value Console or the Acquisition Workstation 
automatically begins to shut down. (For example, if the site has a power failure or if a 
Main power supply circuit breaker is shut off.) When power is lost, an ordered shutdown 
begins after approximately two minutes. This shutdown must be allowed to complete 
before the UPS is turned Off. Then both UPS systems beep repeatedly and can be shut 
down until the power is restored. Refer to the User Guide for UPS directions. 

If the Acquisition Workstation does not respond to the Power button, reset the 
Uninterruptible Power Supply (UPS). 

For example: If power is removed from the Acquisition Workstation (such as power source 
disconnected or circuit breaker switched off) and then returned, the UPS may not automatically 
respond.  

In rare situations, the Acquisition Workstation or Value Console computer can become 
locked up (unresponsive to user input) and must be turned off and restarted. In some 
cases, the UPS can also require a reset. 
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5.2 Controls and Displays 

5.2.1 Compression Device Controls and Displays 
 

Figure Legend 

1. Compression Handwheels. 

2. AEC Sensor Position controls. 

3. AEC Sensor Position Display. 

4. Compression Force Display shows the 
compression force through the range of 10 lb ±1 lb 
to 67.4 lb (44.5 N to 300 N) in 1 lb (4.4 N) 
increments. Dashes are shown for force less than 
10 lb. 

5. Compression Thickness Display shows the 
thickness between 0 and 15 cm above the image 
receptor in 0.1 cm increments. 

 
Figure 64: Compression Device 

 

 
 

5.2.2 Dual Function Footswitches 
 

 Warning: Put the footswitches away from the patient and 
C-arm area to prevent any accidental footswitch 
operation. When the patient has a wheelchair, put the 
footswitches away from the area. 

 

 

The system incorporates two 
footswitches for C-arm and Compression 
Up/Down movement. 
Locate the footswitches for easy access 
from either side of the C-arm. 

Figure Legend 

1. C-arm Down 

2. C-arm Up 

3. Compression Down 

4. Compression Up 
 

Figure 65: The Dual Function Footswitch 
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5.2.3 C-Arm Controls 

Function Detailed Description 

Counterclockwise C-arm Rotation 

 

When you press a C-arm Rotation switch, rotation commences 
immediately and ceases when you release the switch. Press this button 
to begin motorized counterclockwise C-arm rotation.  
C-arm movement is disabled when compression force of 58 N (13 lb) or 
greater is applied. 
The C-arm Angle Rotation Displays on the Gantry reflect the changes in 
rotation. Rotating the C-arm counterclockwise changes the display to a 
more negative reading. 
After making an oblique exposure, the C-arm angle is stored in memory. 
When you rotate the C-arm past 0 degrees for the next exposure, the 
system automatically pauses the C-arm at the opposite oblique angle. 
When you press a Gantry Rotation switch, rotation commences after a 
short delay and stops after a pre-programmed amount of travel. 
Service configures the rotation detent position for the Gantry switches 
from 10-100 degrees of rotation; the default is 45 degrees. 

• Press and hold a Gantry Rotation switch; audible beeps indicate 
the C-arm is about to move, then movement starts. Movement 
stops when the pre-programmed rotation angle is reached. 

• Press the center button and the C-arm moves to the zero degree 
position. 

Clockwise C-arm Rotation 

 

Compression Down 

 

Pressing a Compression Down button: 
• Engages the compression brake. 
• Turns on the light field lamp. 
• Lowers the compression device. 

Note:  Once activated, the compression brake remains engaged until 
compression release is pressed. 
Compression down movement stops: 

• Upon release of the button. 
• At the compression down force limit. 
• At the lower compression travel limit. 
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Function Detailed Description 

Compression Up 

 

Pressing a Compression Up button: 
• Raises the compression device. 
• Does not release or activate the compression brake. 

Motorized compression up movement automatically stops: 
• Upon release of the button. 
• Upon reaching the upper compression travel limit. 

Compression Release 

 

Pressing the Compression Release button: 
• Releases the compression motor brake. 

Raises the compression device approximately 10 cm. 
Note: the system disables all compression release functions when a localization 
paddle is installed (including automatic compression release, if enabled). Patient 
release is available through the compression up functions.  

C-arm Up 

 

Pressing this button moves the C-Arm up. Motorized C-arm movement 
automatically stops upon release of the button or upon reaching the 
upper C-arm travel limit. 
C-arm movement is disabled when compression force of 58 N (13 lb) or 
greater is applied. 
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Function Detailed Description 

C-arm Down  

 

Pressing this button moves the C-Arm down. Motorized C-arm 
movement automatically stops upon release of the button or upon 
reaching the lower C-arm travel limit. 
C-arm movement is disabled when compression force of 58 N (13 lb) or 
greater is applied. 

Light Field Lamp 

 

Pressing the Light Field Lamp button turns on the light field lamp for 
approximately 30 seconds, permitting you to visualize the x-ray field. 
The light field lamp automatically turns on whenever a Compression 
Down button is activated.  

Collimator Override 

 

The Collimator Override button allows the collimator to cycle through 
the available calibrated x-ray fields.  
Choice of the collimator mode, Automatic or Manual, is made in 
Edit>Standard Setup. 
Press the Light Field Lamp button to visualize the x-ray field, and then 
press the Collimator Override button. 
The collimator device moves to another field size and the light field size 
changes. 
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Function Detailed Description 

Smart Paddle System 

 

Smart Paddles shift ~2.5 cm into a left, center, or right position. While 
compression is applied, the paddle cannot be unlocked. The collimator is 
programmed to follow the position of the Smart Paddles. 
1. Rotate and hold the knob on the side of the paddle to shift the 

paddle into one of the detent positions. 
2. Move the paddle into the correct position. 
3. Release the knob to lock the paddle in place. 

AEC Position 

 

Change the AEC Position by: 
• pressing one of the arrows on the compression device top 
• using a function key at the Acquisition Workstation or Value 

Console 
• selecting an up/down arrow on the display 

The AEC has an Auto setting. Move the AEC position beyond #7 or #1. 
The Auto position indicator on the compression device illuminates and 
the Acquisition Workstation display indicates Auto.   
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5.3 Operator Radiation Shield 
The system’s radiation shield is permanently mounted on the Acquisition Workstation or 
the Value Console. 

 
Figure 66: Acquistion Workstation Radiation 

Shield 
 

Figure 67: Value Console Radiation Shield 

 

 
 

5.4 Background for the VOS Switch on the Mobile Selenia 
Switches located in the Gantry limit the C-arm vertical travel to a pre-defined range. 
When the C-arm reaches its highest or lowest point of normal travel, the switches engage 
to stop further motion. If the C-arm should travel past the Limit switches (in the event of 
switch failure or other electrical malfunction), a second switch engages that removes 
power from the system. A Field Engineer would normally be contacted to repair and 
restart the Selenia. 

In a mobile environment (during transport), it is possible for the C-arm to 'creep' 
downward and beyond the two Limit switches. If this occurs, the Selenia would be 
disabled—the lower limit switch would engage, preventing the system from normal 
startup. This is not a failure condition that would require a Service Engineer's attention. 
The Vertical Position Override Switch (VOS) is used to allow the operator to start the 
system and raise the C-arm to within its normal working limits. 
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Chapter 6 
Chapter 6The Manager Functions 

6.1 User Identification 
The Acquisition Workstation first identifies the user at the login process with these 
Operating System and User Accounts: 

• tech - a single x-ray technologist user account, a group login for all technologist users. 
• mgr - a manager user account for the Acquisition Workstation system administrator. 
• phys - a medical physicist user account with special tools for the physicist. 

 

6.1.1 User Assignments 
When logged into the Acquisition Workstation, each individual user views a consistent 
set of screens saved by the Operating System for them. The Operating System user login 
determines which access level a user has to the Acquisition Workstation functionality. 
When the Operating System user is tech, mgr, or phys an Acquisition Workstation Login to 
system dialog box appears. 

The manager configures user login information. The Acquisition Workstation maintains 
both user identity and passwords in a file. The user logs in by selecting from a list of users. 
The password is typed in and must contain at least six characters. These designators 
identify the individual who acquired the images.  

A user can be assigned more than one Operating System access level and thus have their 
application login appear at more than one level. For example, the manager may configure 
the following user identifications: 

• Chief - both tech group and mgr user 
• King - mgr group 
• Joe - tech group 
• Mary - both tech group and mgr user 
• Sally - tech group 
• John - phys group 
The technologists identified by "Chief" and "Mary" may log in as either the Operating 
System user of tech or mgr. Their IDs appear in the User Identification list in either case. 
Depending on which Operating System login they are under, they may perform either 
normal tech functions or manager functions. However, if the user “Chief “only had access 
level mgr, their user identity and login would not appear if the Operating System login 
was tech. The technologists identified as "Joe" and "Sally" only appear when the Operating 
System login is tech, and they have only normal tech level access to the Acquisition 
Workstation. The technologist identified as "King" only appears when the Operating 
System login is mgr, and "King" only has mgr level access to the Acquisition Workstation. 
The physicist identified as "John" only appears when the Operating System login level is 
phys. 
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6.2 Main Menu Functions 
The Main Menu functions are always available except when a dialog box is presented. 
The table below indicates the state of the Main Menu functions for the tech and mgr 
Operating System users when a Patient/Procedure is not selected—italics indicates that 
the button is visible but inactive. Your logon level determines the availability of some 
Main Menu functions. 

Table 9: Main Menu Functions by User (Patient/Procedure Not Selected) 

Menu Function Tech Mgr 
File Exit Exit 
Edit Standard Setup Standard Setup 

View Order Editor View Order Editor 
User Setup User Setup 
Outputs Outputs 

Info About the Acquisition 
Workstation 

About the Acquisition 
Workstation 

Alarms Alarms Alarms 
Procedure Buttons Sign Out Sign Out 

Search Search 
Patient (New/Edit/Close) Patient (New/Edit/Close) 
Procedure (New/ Edit/Add) Procedure (New/Edit/Add) 
Outputs Outputs 
Non-Imaging Mode Non-Imaging Mode 
Simulate Capture Simulate Capture 
Review Review 

 

The Close button in the Patient box, active only when you have the Choose a Procedure 
window displayed, enables you to close the Choose a Procedure window without 
opening any procedures. 

 

These Main Menu functions are available when a procedure is open. Bold indicates 
operational. Italics indicates visible but inactive. 

Table 10: Main Menu Functions by User (Patient/Procedure Selected) 

Menu Function Tech Mgr 
File Exit Exit 
Edit Standard Setup Standard Setup 

View Order Editor View Order Editor 
User Setup User Setup 
Outputs Outputs 
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Table 10: Main Menu Functions by User (Patient/Procedure Selected) 

Menu Function Tech Mgr 
Admin Image Management 

Managemeanagement 
Spool Management 

Protect Patients Protect Patients 

 Set Date and Time 

 Delete Patients 

 Reject Management 

Manage Queues Manage Queues 
Eject Eject 
Import Import 
Retrieve Priors Retrieve Priors 

 Log Backup 

Calibrate Calibrate 
Test Patterns Test Patterns 
DR Device Control DR Device Control 
Available Disk Space Available Disk Space 

 Paddle Configuration 

Info About the Acquisition 
Workstation 

About the Acquisition 
Workstation 

Alarms Alarms Alarms 
Procedure 
Buttons 

Sign Out Sign Out 
Close Procedure Close Procedure 
Patient (New/Edit/Close) Patient (New/Edit/Close) 
Procedure (New/Edit/Add) Procedure (New/Edit/Add) 
Outputs Outputs 
Non-Imaging Mode Non-Imaging Mode 
Simulate Capture Simulate Capture 
Review Review 
Add View Add View 
Remove Unexposed Remove Unexposed 
Implant Present Implant Present 
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6.3 Edit Menu—Mgr Level 

 
Figure 68: Edit Menu 

 

Table 11: The Edit Menu for mgr Logon 
Menu Item Where Item Is Discussed 

Standard Setup Standard Setup Screens on page 75 
View Order Editor View Order Editor 
User Setup User Setup—Add or Edit a User on page 76 
Outputs Set Up Outputs on page 77 

 

 
 

6.3.1 View Order Editor 
This Edit Menu item is only available to the Mgr login. It sets the site’s default View 
Order. This is the order the Views appear if they are not reordered by the technologist. 

Each technologist can determine their own View order for performing a procedure. If they 
have set a View order, their setting determines their View order. 

 
Figure 69: View Order Editor 
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6.4 Admin Menu Functions—"mgr" User Level 

 
Figure 70: Admin Menu for the Mgr Logon 

The Admin Menu items discussed in this section are those only available to the mgr login. 
The table below indicates where each topic on this menu is discussed. 

Table 12: The Admin Menu for Mgr Logon 
Menu Item Where Item Is Discussed 

Spool Management Spool Management on page 112 
Protect Patients Protect Patients on page 89 
Delete Patients Delete Patients on page 117 
Reject Management Reject Management on page 118 
Manage Queues Manage Queues on page 89 
Eject Eject on page 92 
Import Import on page 93 
Retrieve Priors Retrieve Priors on page 94 
Log Backup Log Backup on page 124 
Calibrate QC Manual 
Test Patterns Test Patterns on page 96 
Dr. Device Control Service Use Only 
Available Disk Space User Guide 
Paddle Configuration Paddle Configuration on page 124 
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6.4.1 Spool Management 
This function changes with the Operating System logon level. The Spool Management 
function allows users to manage the image spool space. 

• tech: resend and repreview images to output devices (labeled "Image Management").   
• mgr: repreview, resend captured images to output devices, and delete them. 

 
Figure 71: Choose a New Patient Dialog Box 

To use Spool Management: 

1. Select Admin>Spool Management. The Choose a New Patient dialog box appears. 
2. Search for a Patient whose images you want. The query works the same as elsewhere. 
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3. Select the Patient. The Spool Management window appears. 

 
Figure 72: Spool Management Window—One Image Selected 

4. Select the images you want to work with. The thumbnails display in the order of 
acquisition. Use the arrows to scroll if there are more than four views. 
If you select a patient with rejected images, you have a thumbnail picture of the 
rejected images and demographics for this patient. When you click on a thumbnail, 
information about that view shows in the upper left area of the screen. 

 

 
Note There is an indication in the upper right pane as to whether 

or not the archive has committed the view to storage, if that 
function is enabled. 

5. Select the tab for the function you want to perform. The details for each function are 
explained in the next sections. 

6. Click Close to exit Spool Management. 
 

6.4.1.1 Resend Function 

The Resend function allows you to query for Patients whose images are still within the 
Image Spool and to resend selected images in the spool to Output Destination devices. No 
Patient or Image object information can be changed from the Resend function. This 
includes Image or LUT modifications and DICOM information such as Patient Name 
spelling, ID, Comments, etc. Images are resent to the selected Output exactly as found in 
the spool.     
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6.4.1.2 Printer Contrast and Density 

The Print Client in Spool Management applies the Lorad Image Processing algorithm 
(using the breast density/contrast control parameter) to the Image data as it is sent to the 
printer. 

If a printed film needs to be changed, select Spool Management, and Resend the patient 
or image. Change the Density and Contrast as necessary for the image. You can resend 
one or many images, and any changes you make to the Contrast and Density apply to all 
images you send and only at that time. They are not saved with the images. 

 

6.4.1.3 What Happens When You Select the Resend Tab 

• A list of available outputs becomes active. The default output is the one currently 
selected in the Patient View window. 

• You can choose to resend all images for the Patient or only selected images. 
• Different options are available, depending on the Output(s) selected. 
• For example, if you have selected a printer, Apply PCE (the Peripheral Contrast 

Enhancement Function which uses a special algorithm to enhance the appearance of 
the mammograms) becomes an option. 

• A Resend button becomes active. 
At this point the following functions are also available: 

• Query for a New Patient. 
• Close Resend without taking any actions. 

 

6.4.1.4 How to Use the Resend Function 

To use the Resend Function: 

1. Select a Patient. 
2. Click the Resend tab. 
3. Select the image to Resend or select Resend All. 
4. Select the Output. The Output selected applies only to the Resend function and does 

not affect Outputs chosen for normal acquisition. Use the Edit Output option to add 
or modify the Outputs. 

5. If the selected Output has a printer, the following Print Image Processing Options 
appear. The printing changes are not saved anywhere. Click the option to select or 
deselect it.  
• Adjust the Contrast and Density for printing. Change by clicking another 

number to increase or decrease.  
• Print True Size (if available at the printer). 
• Apply PCE (the Peripheral Contrast Enhancement Function uses a special 

algorithm to enhance the appearance of the mammograms). 
• Omit Patient Name. 
• Omit Label options. 
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6. Click Resend. A dialog box confirms the resend has been performed and the number 
of images resent. Click OK. 

7. Click Close when you are finished with the Spool Management function. 
Writing images to a CD takes longer than saving or printing them. For this reason it is 
usually best to use the Resend option and write them after the procedure is finished. This 
has the advantage of not slowing down the rest of the procedure while you are waiting for 
the program to write to the CD during Image Acquisition. 

 

6.4.1.5 Image Review Function (Also Known as Repreview) 

The Image Review function allows you to recall a Patient Image for review and 
modification. All modifications made during the review are saved with the new image. 
Additionally, the DICOM tag Image Type attribute (0008,0008) is set to 
"DERIVED\SECONDARY." A unique DICOM Image instance UID is created for the 
image. The image is reclaimed using standard reclaim rules. 

You have all the capabilities as in the original Preview (other than reject and accept). The 
differences from the standard Preview function include: 

• The image is not sent to any output devices. If you need to send the image to an 
output device, use the Resend function. 

• Save and Cancel buttons are available. 
Save creates a new image for the Patient. The original image is not modified in any 
manner. When you click Save, you save only the changes in markers, orientation, and 
comments. Printer changes are not saved. 

Cancel closes the Preview window and displays the Spool Management window. 

 
Figure 73: Repreview Window 
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To use the Repreview Function: 

1. Select a Patient from the Choose A New Patient list. 
2. Select the image to review. 
3. Click the Repreview tab. 
4. Click Repreview. The Repreview window appears. 
5. Perform the actions and then click either Save or Cancel. 
6. Click Close when done with Spool Management. 

 

6.4.1.6 Archiving Patients with Acquired Images 

1. Select Spool Management from the Admin Menu. 
2. Click Search and select the Patient name from the list. The Review Images window 

appears. 
3. Click the images you want to resend, or select Resend all the images. 
4. In the Setup window, select any other choices. Select the Output for archive. 
5. Click Resend. 
6. Close the Spool Management dialog box. 

 

6.4.1.7 Correcting Incorrect View Selections 

The Repreview function is used to correct an incorrect view exposure if the error was not 
corrected before clicking Accept. See Exposure Taken Using an Incorrect Icon on page 52. 

 

6.4.1.8 Delete Image Function 

This function allows you to delete all or selected image(s) of a patient from the hard drive. 
Use this feature to delete incorrect images that are corrected and resent. When you click 
Delete, a dialog box reminds you that the image will be permanently deleted from the 
Image spool. 

To use the Delete Image function: 

1. Select the image to delete. 
2. Select the Delete tab. 
3. Click Delete Selected to choose the Patient Images, or Delete All for Patient. 
4. Click Yes in the Confirm Operation dialog box. 
5. Click Close when done with Spool Management. 
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6.4.2 Set Date, Time, and Zone 
 

 
Note The Set Date, Time, and Zone feature is a manager function. 

To set the date, time, and zone: 

1. Press the Diamond key (or the Windows key). 
2. Double click on the date in the right hand corner. 
3. Make the appropriate changes as required. 

 
 

6.4.3 Delete Patients 
This option at the mgr level lets a manager delete patients from the Local Exams and all 
images for those patients from the Image Spool. Exported images and patients are 
routinely reclaimed, and do not need to be deleted manually.  

You can delete a patient under the following circumstances: 

• They have no rejected images in the reject bin. 
• All their related images are exported or deleted from output queues. 
To delete a patient: 

1. Select a patient name from a list, or use the patient name query to search for the 
patient. The Delete button activates when a patient is selected. 

 
Figure 74: Delete Patient Window 

2. Click Delete. A dialog box might appear to tell you why the deletion is not possible or 
that the patient is protected. If there are protected patients in your selection, a 
confirmation to delete message appears. If the message says, for example, the patient 
has jobs in the reject bin and/or the output queue, the jobs must first be deleted or 
allowed to pass through the queue. Otherwise, a Delete Selected Patients and 
Images dialog box appears. 

3. Click Yes. The patient and all related data are deleted. 
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6.4.4 Reclaiming 
The Acquisition Workstation computer hard drive automatically stores the acquired 
images. Information that is successfully sent to other storage is routinely reclaimed from 
the hard drive to make room for new patient information. 

The system automatically reclaims hard disk storage space for new procedures using 
configurable parameters. The image reclaimer deletes images from the system when a 
number of images (service configurable) have collected on the system. When reclamation 
of images begins, images continue to be reclaimed until the number of images on the 
system reaches a lower service configurable number.  

The following reclamation rules use the factory default parameters: 

• If there are more than 2000 images on the system, then the 25 oldest images are 
reclaimed. No procedure is left with missing images. 

• Patients with no images are reclaimed. 
• If there are more than 700 patients, then the 50 patients (and their images) with the 

oldest Procedures are reclaimed. 
The following is a list of exceptions to these rules: 

• No patients are removed if there are any images queued to an output device. 
• No images are deleted for protected patients. (Protect a patient by using the Main 

Menu function Admin>Protect Patient. Be sure to unprotect them.) 
• No images queued up on an output device are reclaimed. 
• No images are deleted that have not been successfully printed on film or committed 

to an archive device, (Archive devices should be set to send commitments). 
• Rejected images are not automatically reclaimed. Managers need to periodically 

remove all Rejected images using Admin> Reject Management. 
 

 
Caution: If the disk does not have enough available space, the 

system does not acquire an image. A message displays the 
capacity of the disk. Delete unneeded images to restore the 
disk space. 
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6.4.5 Reject Management 
This function allows a mgr user to manage the Reject Bin. The System Reject Bin provides 
the following functions:  

• Delete rejected images 
• Display the Reject Bin percentage full 
• Select a patient with rejected images and review the images 
• View a report of rejected images 
Have a local procedure in place for routine examination and removal of rejected images. 
Rejected images are not automatically reclaimed and can fill up the hard drive. 

 
Figure 75: Reject Management Window—(Delete is Shown) 
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6.4.5.1 View a Patient’s Rejected Images 

When you select a Patient with Rejected Images, you have a thumbnail picture of each of 
the patient’s Rejected Images and this information in the upper left pane: 

• Patient Name 
• If they are protected 
• Patient ID 
• Patient Birth Date 
• Number of images in the Procedure 
• Procedure number 
• Procedure name 
When you click on a thumbnail, information about that view is displayed in the upper 
right pane: 

• Image view 
• Date and time of capture 
• Tech 
• All image and technique information including the paddle used 
• If it is Committed 
• Comments 
• Last six digits of UID 
These Tabs allow you to administer the selected patient’s images: 

• Delete—Delete a selected (or all) image(s) permanently from the Reject Bin. 
• Resend—Select an output and resend a selected image to the output. 
• Repreview—View the image 
The Rejected Images and the comments are stored in the Reject Bin. DICOM attributes 
associated with the image and the LUT are held in the Reject Bin in the same manner as 
Accepted Images. 

Proper image evaluation should be performed under the Repreview function to ensure 
effective image evaluation management. 
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6.4.5.2 Repreview Rejected Images 

 
Figure 76: Repreview Tab on Reject Management Screen 

To repreview rejected images: 

1. Select Admin>Reject Management 
2. Click Choose a New Patient. 
3. Search for the patient in the Choose a New Patient dialog box. The patient’s rejected 

images are displayed in the lower left pane. 
4. Click the image you want to review. Image information is in the top of the box. 
5. Click the Repreview tab, the Repreview option button is active. If the Repreview 

button does not display, contact service. 
6. Click the Repreview button. The Repreview screen appears. 
7. Click Save or Cancel to close the Repreview screen. 
8. Click on the Delete tab to delete them, or click on the Resend tab to resend them to an 

output and then delete them. 
9. Click Close to close Reject Management. 
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6.4.5.3 View Rejected Images Report 
There are two different Rejected Images Reports. One on screen where you can see the 
rejected images, and one in the network browser that presents statistics and can be 
printed if the computer you are using is connected to a printer. For information on using 
the printable report, see Repeat/Reject Reports Options Available from the Browser on page 
125. 

When you choose to view the Rejected Images Report, you are able to filter the report to a 
single technologist, or view all technologists. The report lists the operator name, date, and 
time for each Rejected Image. Selecting a Rejected Image in the report shows the same 
information as explained in the previous section, View a Patient’s Rejected Images on page 
119. 

To review the rejected images report: 

1. Select Admin>Reject Management. 
2. Click Rejected Image Report. 
3. Search for a technologist in the Choose an Operator dialog box or click Search to 

search for all technologists with rejected images. 
4. Select a technologist from the list. The technologist’s rejects for the procedure on the 

date and time listed display on the screen as thumbnails. 
5. Click on the Repreview tab to review them. Click on the Delete tab to delete them, or 

click on the Resend tab to resend them to an output and then delete them. 
6. Click Close to close Reject Management. 

 

6.4.5.4 Delete Images from the Reject Bin 

When rejected images are no longer needed, delete them. 

To delete images from the Reject Bin in Reject Management by patient: 

1. Select a Patient (you can review and resend the image before you delete it). 
2. Click the Delete tab. 
3. Select the thumbnails of the images to delete and click Delete Selected, or click Delete 

All for Patient to delete all images for the patient. 
To delete them by the technologist who acquired them, use directions in View Rejected 
Images Report on page 121. 
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6.4.5.5 Resend Images from the Reject Bin 

 
Figure 77: Reject Management—Resend a Rejected Image 

To resend the image before you delete it: 

1. Select the Resend tab. This window functions the same as those in the regular Resend 
Menu. 

2. Click Resend selected images or Resend all images for patient. 
3. Select the Output. The Output selected applies only to the Resend function and does 

not affect Outputs chosen for normal acquisition. 
4. If the selected Output has a printer, the Print Image Processing Options activate. The 

printing changes are not saved anywhere.  
• Adjust the Contrast and Density for printing. Select a different number to make a 

change.  
• Print True Size (if available at the printer). 
• Apply PCE (the Peripheral Contrast Enhancement Function uses a special 

algorithm to enhance the appearance of the mammograms). 
• Omit Patient Name. 
• Omit Label options. 
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5. If you are done with the image and are ready to delete it, click Delete tab and select 
the images to delete if the selection has changed. 

6. Click Delete or Delete All for Patient. This only deletes images in the reject bin. 
7. Click Close to close Reject Management. 

 

6.4.6 Log Backup 
When Service requests it, Log Backup saves copies of the system log files to a CD-R.  

To back up Log Files: 

1. Select Log Backup from the Admin menu. The Backup dialog box appears. 
2. Select Backup to CD-R, then click Continue. 
3. Insert a blank CD-R into the CD-RW device. 
4. Click the Test Blank CD-R button. The message “Blank CD-R found” appears. Click 

Continue. 
5. Click Done after the files are backed up. The disk auto-ejects. 
6. Label the disk according to your site procedures and store it safely or send to Hologic 

if requested. 
 

6.4.7 Paddle Configuration 
This menu option sets up the paddles available to your site. If these options are not set up 
correctly, an " Incorrect Paddle Position" alarm message appears. 

 
Figure 78: Paddle Configuration Dialog Box 

To check a Paddle Configuration or add/change an available View for a paddle: 

1. Click the arrow for the drop-down list in the center. 
2. Select the paddle you want to View/Configure. Your selection appears on the Paddle 

ID info line. 
3. Select Left, Center, or Right paddle position for all shifting paddles. 
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4. Check (or clear) the Allowable Views for that paddle. 
5. Repeat Steps 1-3 for each paddle you want to configure and for each paddle position. 
6. Click Done when finished. 

 

6.5 Info Main Menu Function 
The Info function identifies the Acquisition Workstation software versions, the current 
temperature of the array, and the date, time, and temperature of the last calibration. 

 
Figure 79: Info Screen 

 

 
 

6.6 ALARM Function 
The Alarm function manages alarms that have occurred due to failed jobs to destination 
devices. For more information on Alarms, see Troubleshooting on page 129. 
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6.7 Repeat/Reject Reports Options Available from the Browser 

6.7.1 Administrative Reporting 
The Reject Analysis Report can be printed for administrative review. It is available from a 
web browser, not from the Selenia application. Any network connected PC can access 
them. 

 

6.7.2 Accessing the Report from Any Computer on the Network 
To access these reports: 

1. Run the Browser program on your machine. 
2. In the Browser Address Bar, type: http://<the system name you want to access> or the 

<IP Address>:8080 and press Enter. A Password dialog box appears. (The system’s IP 
address is recorded in an Appendix of the Installation Manual.) For additional details, 
see Can I Run the Repeat/Reject Analysis from an Office Computer? on page 19. 

3. Exit from the Browser when you are done to maintain security. 
 

6.7.2.1 Log In Using the Admin Password 

 
Figure 80: Log on to the Browser 
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Figure 81: Administrative Reporting Options 

You can choose to change the browser’s password or open Repeat/Reject Analysis. 
 

6.7.3 Change Password 
This changes the browser’s password for a Selenia system. Do not change this without 
system wide agreement. 

 
Figure 82: Change Password 
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6.7.4 Reject Analysis Report 
1. Click the Reject option. 
2. Choose the Report Parameters to view. 
3. Click Submit. The request is sent to the computer and the information is collected and 

formatted into a report.  
4. Set the page to Landscape, and print the report using the browser Print button. 

 
Figure 83: Criteria for Reject Analysis 

To Save the Reject Report as a Shortcut on your desktop: 

1. With the Reject Report Parameters page showing, click Add to Favorites in the 
browser. 

2. In the dialog box that appears, type Selenia Reject and the room number if there are 
multiple units. 

3. Click the appropriate button to save the favorite. 
4. Once the favorite is saved, click Favorites. 
5. Highlight the link you saved. 
6. Right-click to display a menu of options. 
7. Click Send To. 
8. Click Desktop (create a shortcut). The shortcut is now on the desktop. 
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Chapter 7 
Chapter 7Troubleshooting 

7.1 Alarm Types and System Messages 
The goal of an Alarm is to provide feedback about abnormal events associated with either 
the Image Acquisition on the Acquisition Workstation or the export of Acquired Images to 
destination devices. 

 
Figure 84: Location of Alarms by Type 

 Figure Legend 

1. Category One Alarm Message 

2. Category Two Alarm Icon 

3. Reset Generator Button 

4. System Information and Messages 

 

There are four basic categories of alarms/messages: 

• Category One - A condition in which the Acquisition Workstation cannot continue. 
• Category Two - A condition in which the operation of the Acquisition Workstation can 

continue (normally associated with a warning or a failure in an output device). 
• Category Three - A condition in which the image processing has failed, displayed on 

the Preview screen. 
• Category Four (System Messages) - A condition in which the system produces 

messages explaining why the system is not going into Ready Mode. 
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7.2 Category One Alarm Functions 
Category One Alarms appear on the screen in the Alarm Message box. A dialog box 
appears for Alarms requiring your immediate input. You must close the dialog box before 
you can acquire an exposure. 

For Category One alarms, a dialog box appears immediately to indicate a problem that you 
are required to acknowledge. Depending on the specific condition, a dialog box asks 
whether to continue or to abort the current action. Some image receptor, generator, and 
internal alarms are Category One.   

 
Figure 85: Category One Alarm Dialog Box 
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7.2.1 Sample Category One Alarm Messages 
The Operator Message for each alarm contains the alarm number, the associated message 
as listed below, and the action required (for example, "Press Reset to continue"). If Reset is 
required, click Reset Generator. 

 

 
Note Some conditions, such as Invalid Paddle Position, remain 

active until the condition is corrected. The Reset command is 
not required; the Acquisition Workstation message clears 
automatically once you correct the condition. 

Sample Alarm Messages 

The table in Category One Alarms on page 135 describes Category One Alarm messages. 

• "Calculated exposure time exceeds max. Exposure Aborted. Press Reset to Continue." 
• "Premature release of x-ray switch. Exposure Aborted. Press Reset to Continue." 

 

7.2.2 Generator Related Alarms 
If the Gantry generator sends a message classified as an alarm, it displays as a Category 
One alarm. See the figure Category One Alarm Dialog Box on page 130. 

 

7.2.3 Digital Image Receptor Related Alarms 
There are four basic classes of alarms associated with the Digital Image Receptor Interface. 
All four are Category One alarms. 

• Startup: The array is not responding at startup. 
• Communication: Communications were lost or incorrect mid-operation. 
• Image Receptor Error: Error reported from Image Receptor. 
• Scan ID Error: The Scan ID does not match the one returned from the array. 
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7.3 Category Two Alarm Functions 
Category Two alarms are generally output problems that occur due to jobs that fail at the 
destination devices. When a new Category Two alarm occurs, the Alarm icon indicates 
that an alarm is present. Viewing the new alarm automatically acknowledges the alarm 
condition. The Alarm icon highlight remains if alarms are still present. Erase the alarm to 
clear it.   

Output queues handle actual output from the Acquisition Workstation. If a physical 
device does not accept an exported job, or if it does not complete successfully, it is retried 
or held as a problem job, depending on the reason for the error. The system performs a 
service configurable number of retries before it generates an alarm. 

Jobs can fail because there is either a problem with a specific part of the job (for example, 
printing requirements that a printer doesn’t support) or because there is a general 
problem with the physical device (for example, the printer is off-line or not turned on). 
The system manages queues automatically to prevent problem jobs from clogging the 
queues. You can view the status of Images that have not left the queue using the 
Admin>Manage Queues menu function.     

An alarm condition is either a warning or a notice. When a message such as a low-film 
condition is received, an alarm of type "warning" is posted to indicate this. However, this 
alarm does not get automatically removed when the low-film condition no longer exists; 
instead, another alarm of type "notice" is posted indicating that the printer status is now 
normal. The "From" column is not the name of the device posting the alarm, but the name 
of the spooler to which the alarm was sent. 

The Category Two Alarm provides the following functions: 

• When you click the Alarm icon, the Alarm 
dialog box becomes active. 

• The Alarm dialog box allows you to: view 
alarms, acknowledge alarms, and erase 
alarms. 

 
Figure 86: Alarm Icon 
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The Alarm dialog box contains the following: 

• Information about the alarm condition: 
• From: Name of the device with the alarm 
• Type: Warning, Notice 
• Subject: Additional system information 
• Time Sent: Time the alarm was posted to the spooler 

• An area that displays the message contents. 
• A list that shows all of the current alarms sorted in reverse chronological order. 
• A Forward/Backward button set that allows you to quickly navigate the alarm list. 
• An Erase and Erase All button that allows you to erase the alarm. 

 
Figure 87: Alarm Dialog Box 

 Figure Legend 

1. Alarm Information 

2. Message Display Area 

3. Scrolling List of Alarms 

4. List Navigation Buttons 

5. Erase and OK Buttons 
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Erase an alarm by selecting the alarm and then clicking Erase. Clicking Erase All returns 
the Alarm icon to normal. Erased alarms are completely deleted. Therefore, they may 
recur, in which case they are treated as new alarms. 

 

 
Note If you accidentally click the main screen when an Alarm 

dialog box appears, re-click the Alarm icon and the dialog 
box re-appears. If a software problem occurs and a screen 
stops responding, right-click the top bar of the problem 
screen and close it.  

 

 
 

7.4 Category Three Alarms 
Category Three alarms are conditions in which the image processing fails and displays on 
the Preview screen. For a list of alarm messages, see the table in Category Three
Alarms on page 138. 

 

7.5 Category Four Alarms (System Messages) 
Category Four (System Messages) appear in the lower right System Message box. They 
indicate why the system is not going into the Ready Mode. The table in System Message 
Information on page 138 lists required user responses to these messages. The dashboard 
panel displays text and changes color (to white) when a system problem occurs. Loss of 
PXCM to Generator link, receptor power loss, and "Paddle not locked" are examples of 
messages that appear in the area. 

An example of a System Message is: 

• "Incorrect Paddle Position." 

 
Figure 88: System Messages 
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7.6 Tables of Messages and User Actions 

7.6.1 Category One Alarms 
 

Table 13: Alarm Messages 

Error # Cause Action 
2 Calculated exposure time exceeds max reset / retake in 

AutoTime mode 
3 X-ray switch not released after exposure reset required 

4 Stuck x-ray switch on startup reset required 
5 Calculated exposure time less than min reset / retake in 

AutoTime mode 
9 Invalid Cal Data (service call required) "non-resettable error" 
20 Rotor error reset / re-expose 
21 No x-ray switch after start from host reset / re-expose 
22 ARC-kV control error reset / re-expose 
23 TUBE OVERCURRENT reset / re-expose 
24 TUBE OVERVOLTAGE reset / re-expose 
25 INVERTER OVERCURRENT reset / re-expose 
26 X-RAY INTERLOCK FAULT reset / re-expose 
27 FILAMENT OVERCURRENT reset / re-expose 
28 FILAMENT OVERVOLTAGE reset / re-expose 
29 FILAMENT GRID FAULT reset / re-expose 
30 HOST TO GEN. COMM FAULT reset / re-expose 
31 HARDWARE BACKUP TIMER TIMEOUT reset / re-expose 
32 FIRMWARE BACKUP TIMER TIMEOUT reset / re-expose 
33 HV GENERATOR TIMING FAULT reset / re-expose 
34 Spot relay error (unable to switch focal spot) reset / re-expose 
35 Tube Undercurrent Fault reset / re-expose 
51 Bucky error: Bucky not responding reset / re-expose 
52 Brick communication error during exposure 

(message block 1 request not received) 
reset / re-expose 

53 No DETECTOR_READY 
(at start of start exposure, or premature de-activation 
during x-ray) 

reset / re-expose 

54 READY signal error 
(premature de-activation during x-ray) 

reset / re-expose 

55 Invalid parameter field received in Block 2 or 3 
command 

reset / re-expose 

56 Invalid value field received in Block 2 or 3 command reset / re-expose 
57 Post Exposure Data Error 

(Selenia did not successfully process post exposure 
data) 

reset / re-expose 
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Table 13: Alarm Messages 

Error # Cause Action 
58 ERROR signal activation 

(premature activation during x-ray) 
reset / re-expose 

59 No mAs received from Brick (New mAs not received 
during AEC exposure) 

reset / re-expose 

60 CCW C-ARM Rotation Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

61 CW C-ARM Rotation Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

62 Lamp Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

63 Comp Up Switch stuck 
(stuck switch detected on start-up) 

inspect switch 

64 Comp Dn Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

65 Comp Rel Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

66 C-Arm Up Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

67 C-Arm Dn Switch Stuck 
(stuck switch detected on start-up) 

inspect switch 

70 No comm from Tubehead reset 
71 filter/mirror error reset 
72 filter error (AF mode) reset 
75 Invalid Paddle Position 

(Compression Paddle shifted to an "in-between" 
position.) 

*self-correcting 

76 Unrecognized Paddle *self-correcting 
79 Compression Device Interference *self-correcting 
80 Stereo LOC II Error Signal Processing Inspect Mag stand 

mounting and stereoloc 
mounting 

82 Stuck Gantry door rotation switches Inspect switches 
100 Brick to array communication (Hotlink cable) Inspect connection 

*Self correcting errors: Error remains active until the error condition is corrected, and 
clears once the error condition is corrected—it does not require a "reset." The alarm 
message on the screen clears once the error clears. 

**Undefined error codes: If any error codes not defined above are reported, the alarm 
message displays "Generator Error#" where # is the error code. Assume that a reset is 
required. 



Selenia User Companion 
Chapter 7—Troubleshooting 

 
 
 
 
 
 

 
MAN-03271 Revision 003  137 
 
 

7.6.2 Category Two Alarms 
Only the key part of the message is included in this table. 

Table 14: Category Two Alarms - Printer or Storage Task 

Message Action Required 

Print request for ID: …, Name: … 
Study: …, Image: … 
to device … has failed and will be retried. 
Reason: Failed to communicate with the printer 
pdev  
:pdevprint_…; will retry 
Please contact Hologic service. 

Please contact Hologic service. 

Print request for ID: …, Name: … 
Study: …, Image: … 
to device … has failed after …attempts, 
and will not be retried. 
Reason: Failed to communicate with the printer 
pdev  
 :pdevprint_…; will retry 
Please contact Hologic service. 

Please contact Hologic service. 

Store request for ID: …, Name: … 
Study: …, Image: … 
to device … has failed after …attempts, 
and will not be retried. 
Reason: Failed to communicate with the remstore 
pdev  
 :pdevremstore_…; will retry 
Please contact Hologic service. 

Please contact Hologic service. 

Store request for ID: …, Name: … 
Study: …, Image: … 
to device … has failed and will be retried. 
Reason: Failed to communicate with the remstore 
pdev  
 :pdevremstore_…; will retry 
Please contact Hologic service. 

Please contact Hologic service. 

Error happened when trying to initialize CD-RW Try another CD. 
CD-R space full, and user selected not to replace 
with a new CD-R 

Resend the image later if you want it 
on a CD. 

CD-R was not recordable, unknown error 
happened 

Try another CD. 
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7.6.3 Category Three Alarms 
Category Three alarms are image processing alarms. An error code in the Exposure Index 
box on the Preview Screen informs you of problems that have occurred. These alarms 
appear on the Preview Screen when image processing fails. 

Table 15: Image Processing Error Messages 
Error # Message 

1000 Image processing is not licensed. 
1001 Image is not FOR PROCESSING. 
1002 Image orientation flag is missing or not supported. 
1003 Paddle ID error. 
1004 Internal configuration does not allow for any outputs! 
1005 Out of range pixel values. 
1006 Calling application did not allocate memory for one or more image outputs. 
1007 Invalid data in input image. Data may not be of a mammographic breast 

image. 
1008 Memory allocation error. 
1009 Error opening configuration file. 
1010 Error opening log data file. 
1011 Data bit depth not supported. 
1012 Missing required input parameter. 
1013 Collimation configuration error. 
1014 Laterality error. 
2000 Density/contrast input parameters out of range 
2001 Pixel manipulation input parameter out of range 
2002 Histogram input parameter out of range 
2003 Unsharp mask input parameters out of range 
2004 PCE input parameters out of range. 
2005 P-Value input parameters out of range 
2006 Print boundary parameters out of range 
2007 Diagnostic density/contrast parameters out of range 
2008 Implant parameters out of range 
2009 Image DC Offset out of range 
2010 MCE parameters out of range 
2011 Diagnostic logistic parameters out of range 
2012 Screening logistic conversion parameters out of range. 

 

 
 
 

  



Selenia User Companion 
Chapter 7—Troubleshooting 

 
 
 
 
 
 

 
MAN-03271 Revision 003  139 
 
 

7.6.4 Category Four System Messages 
Table 16: System Messages 

Message Meaning Action 
Incorrect paddle 
position 

This indicates that the 
paddle position is not valid 
for the selected patient view. 

Correct the paddle position. The 
Selenia system only allows the 
use of certain paddles with 
specific views. If this message 
appears, you may need to 
change the position of the 
paddle or use a different 
paddle. 

Paddle not locked This indicates that the 
paddle is between positions 
(left, center, right). 

Shift the paddle until it clicks 
into position. 

Remove paddle for 
calibration 

This indicates that a paddle 
is present and a calibration 
scan is being requested. 

Remove the paddle for 
calibration. 

Detector power The PXCM is reporting that 
the power to the detector has 
been removed. 

Make sure the gantry has 
power. Examine the emergency 
stops switches (three) to be sure 
the switches are off, and the 
circuit breaker to be sure it is on 
(up). Reboot the system. If the 
condition persists, contact 
Service. 

Detector service mode This indicates that the 
detector is in service mode. 

Reboot the system. If condition 
persists, contact Service. 

Calibration needed This indicates that a 
calibration is needed and 
could be the result of a 
calibration file that is beyond 
the calibration life span. 

Perform a calibration. 

Generator problem The PXCM has lost its link 
with the generator. 

Reboot the system. If condition 
persists, contact Service. 

Detector problem The PXCM has lost its link 
with the detector. 

The imaging subsystem has 
reported that it lost the link 
with the detector. Reboot the 
system. If condition persists, 
contact Service. 

Detector hi temp The PXCM is reporting that 
the detector hi temperature 
has been reached and is in 
danger of being turned off. 

The detector reached the high 
temperature. 
Shut down the system. Contact 
Service. 
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Table 16: System Messages 

Message Meaning Action 
Detector not present This is a reminder that the 

acquisition workstation was 
started without a detector 
present. 

Not Applicable 

Non Acquisition Mode This is displayed during 
review and test pattern 
generation and indicates that 
the system cannot be used to 
take patient exposures. 

Not Applicable 

Detector shutdown in 
(n minutes) 

This indicates that the 
detector is about to be 
shutdown in n minutes. 

Click Cancel Shutdown if you 
are still working. The detector 
does not shutdown until the 
backup shutdown time. 

 

 
 
 

7.7 Software Troubleshooting 
 

Table 17: Software Troubleshooting 

Symptom Probable 
Cause 

User Directions 

White screen 
with message: 
program 
terminated 
ok 

Power 
problems 

1. Turn off the circuit breaker on back of 
Acquisition Workstation. 

2. Wait for UPS to stop beeping (a minimum of 10 
minutes). 

3. Turn the circuit breaker switch back on. 
4. Press the Acquistion Workstation On button. The 

computer restarts. 
5. Log on to the Operating System. 

 
Figure 89: Acquisition Workstation Circuit Breaker 
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Table 17: Software Troubleshooting 

Symptom Probable 
Cause 

User Directions 

Forgot user 
password 

 Delete user account and re-enter. 

Cannot make a 
"tech" into a 
"manager" 

Logged in as 
tech. 

A Manager performs this action. 
Delete user account and re-enter it when logged on as 
a Manager. 

Panel Power 
dialog box 
continues to 
reappear after 
using the 
Emergency Off 
Switch 

Reset or 
restart the 
system. 

Select the Reset Generator button after selecting OK. 
If that fails to work, restart the system. Shut down the 
System following the procedure How Do I Turn the 
System Completely Off? on page 4. After waiting a few 
minutes, press the power button to restart the 
system. 

No screen 
function, cursor 
still moves 

Dialog box 
hidden behind 
main screen. 

If you accidentally click the Main screen when an 
Alarm dialog box is displayed, click the Alarm icon 
and the dialog box is redisplayed. 
1. If the main screen appears to be non-functional, 

click the upper right corner dot of the Main 
screen bar. The screen minimizes to an icon that 
says Lorad. 

2. Close any open application dialog boxes (not the 
little icon boxes on the left). 

3. Double-click the application icon to return it to a 
full screen. 

If the Task Launcher screen is accidentally closed, 
restart the application. 
4. If a screen does not function, and there is nothing 

behind it after you have minimized the 
program—click the Exit button on the Operating 
System task bar at the bottom of the screen. 

5. Log out of the session. 
6. Click OK on the Logout Confirmation dialog 

box. 
Call field service if these solutions do not work. Do 
not turn off the Acquisition Workstation circuit 
breaker with the program running. 

Lorad wallpaper 
appears 

Open key 
pressed. 

Press the Open key again or click the application icon 
on the left and program reappears. 
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Table 17: Software Troubleshooting 

Symptom Probable 
Cause 

User Directions 

Incorrect paddle 
position message 
fails to go away 

Changed or 
moved paddle 
while Preview 
screen was 
displayed. 
Paddle not 
recognized. 

• Restore the previous paddle or position. Also 
click Reset Generator. 

• Seat paddle to confirm good connection. 
• Examine Paddle Configuration table. 

Collimation on 
spot paddles is 
wrong 

Automatic 
Collimation 
was turned off 
in setup. 

Turn Automatic Collimation back on and leave on. 

Error 100 Error 
transferring 
preview 
Image. 

Restart the system. Be sure to restart the computer 
every morning. 

RPC3-Write 
error 

Faulty 
generator 
communica 
-tions, brick, 
cabling, etc. 

Call Service. 

Cannot delete 
patients 

Logged in as 
tech. 

Log in as Manager. 

Image Washed 
out 

 Evaluate exposure bar, it should be above 250. 

CD-RW does not 
respond 

 • Wait five minutes before trying again. 
• Look at CDRW spooler in Manage Queues to 

see if Images are still being transferred. 
• Wait until Image transfer has finished before 

retrying. 
• Try a different media. 
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7.8 Worklist Problems 

7.8.1 Unknown RIS Code 
A dialog box appears if the RIS code that the Modality Worklist Provider (Radiology 
Information System or PACS) returns does not map to an existing procedure on the 
Acquisition Workstation. Your options are: 

• Click Cancel because the previous selection was incorrect. 
• Select the correct procedure from the drop-down list and click OK. 
• After the patient is completed, contact your local IS department to ensure that the RIS 

code matches your expectation. Then, if it is still a problem, contact the Selenia help 
desk for assistance in using the Procedure Editor to add the new RIS code. 

 

7.8.2 Conflict Between Data in the Modality Worklist and Local Database 
When a conflict between the worklist and local database does occur, work with the 
HIS/RIS administrator to resolve this issue. 

If a Modality Worklist Error dialog box indicates that there is a conflict between the 
worklist data and an existing patient in the local database, verify that you have selected 
the proper record. Make sure that a mistake has not been made during scheduling and 
identifying the patient and procedure. 

If you are to assign a new Accession Number, follow this procedure. 

1. Click OK in the MWL error data box. A New Procedure dialog box appears. 
2. Type a new Accession number and select the procedure. 
3. Click Accept. A new Procedure is added for the Patient. 
Another workaround to consider would be to have a manager delete the old record and 
then reselect the worklist item. 

 

  



Selenia User Companion 
Chapter 7—Troubleshooting 
 
 
 
 
 
 

 
144 MAN-03271 Revision 003  
 
 

7.8.3 Resolving Patient Data Conflicts 
Depending on which field doesn’t match, a dialog box may be displayed allowing you to 
enter the Local Database information. These changes only apply to the Local Database on 
the Acquisition Workstation, and do not correct mistakes on the Modality Worklist 
Server. Inform your HIS/RIS administrator of this issue and work with them to resolve it 
so that images do not get lost. When you have finished correcting the discrepancies, click 
OK. The Patient’s screen appears. 

 
Figure 90: Worklist Patient Conflict Dialog Box 
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Index 
A 
accept 

Accept button • 48 
image • 48 
reject accepted image • 51 
rejected image • 17, 50 
Resend • 85, 86 

images • 11, 14, 86 
tech functions • 85 

Accept button • 48 
accepted image 

destination devices • 78 
patient view screen thumbnail • 52 
review dialog box thumbnails • 50 

access levels • 107 
Acquisition Workstation 

local database (Local Exams) • 29 
add 

additional procedure • 36, 61 
additional view to procedure • 59 
new procedure 

to Open Patient • 61 
with new accession number • 60 

patient • 33 
Admin menu 

mgr • 111 
tech • 85 

administrative browser, change password • 126 
Administrative Reporting • 126 
AEC 

Auto sensor position • 42 
exposure adjustment settings • 41 
generator 

related alarms • 131 
modes • 5, 40, 41 
sensor position settings • 42 
technique defaults • 75 
using • 5, 40 

alarms • 129, 132, 138 
Category One • 135 
Category Three • 138 
Category Two 

alarm icon and dialog box • 132 
alarm list • 137 
CDRW alarms • 137 
DICOM alarms • 137 
number of alarms • 132 
Repeat Bin alarms • 137 

CD • 84 
functions • 125 
image receptor • 131 
image spools • 132 
incorrect paddle position • 13, 139 
Info menu • 125 
managing • 125 
output queues • 132 
paddle not locked • 13 
re-display • 132 

allowable views, paddles • 124 
AUTO AEC sensor position • 42 

B 
bar code scanner, use • 30 
bar codes • 68 
button (software) 

Accept • 48, 60 
Add (Procedure) • 61 
Add View • 12, 59 
Brightness/Contrast (Window/Level) • 48 
button locations on Patient View screen • 37 
Cancel/Clear • 60 
Clean Up • 96 
Close (in Patient box) • 108 
Close Procedure • 37, 58 
Comments • 45 
Edit • 108 
Edit Patient • 37 
Edit Procedure • 37 
Eject • 13 
Exit • 24 
Import Priors • 94 
Measurement • 47 
New Procedure • 36, 60 
Non-Imaging Mode • 63 
Quick Zoom/Pan • 46 
Reject • 49 
Remove Unexposed Views • 59 
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Retrieve and Import • 94 
Review • 64 
ROI (Region of Interest) • 47 
Search • 33, 34 
Set Accepted • 50 
Set Rejected • 51 
Set Technique Defaults • 75 
Simulate Capture • 64 
Window/Level (Brightness/Contrast) • 48 

C 
calibration • 23 
captured images, resending • 112 
C-arm 

alarms • 135 
controls • 69 
movement • 69 

CD, CD-RW 
alarms • 84 

initialization error • 137 
not recordable • 137 

eject disks • 92 
import images from • 84, 93 
Outputs • 82 
patients on a • 13 
space full alarm • 137 
use • 84 

CD-RW drive • 84 
as output • 78 
virtual device name • 84 

Center/Width, set • 48 
change Patient Information, Accepted Image • 62 
change users • 5 
Choose a Procedure, Close button • 108 
Clean Up button • 96 
clinical procedures • 65 

AEC mode • 67 
manual mode • 65 
TEC mode • 66 

Close 
Exam key • 58 
Patient button • 60 
Procedure button • 37, 58 

collimator 
startup defaults • 75 

comments 
enter or modify • 45 
required • 49 

Communication with the generator is lost • 26 
compression 

release modes • 75 
compression force • 75 

startup defaults • 75 
contrast for printer, adjust in 

Image Management • 86, 114 
Reject Management • 123 
Resend • 11, 87 

cropping, automatic • 48 
Crosshairs, use • 71, 73 

D 
daily restart • 25 
data storage (Outputs) • 82 
database 

available • 28 
conflict • 143 
corrupt • 140 
local • 29, 33 
Local Exams tab • 33 
organization • 28 
synchronization • 29 

defaults 
exposure modes • 39 
set system • 75 

delete 
images • 116 
images from Reject Bin • 120, 122 
job in queue • 92 
output • 81 
patients • 117 

Delete tab • 116 
in Reject Management • 123 

density, adjusting for reprinting in Spool 
Management, Resend • 114 
desktop shortcut, Reject Analysis report • 20 
determine job status • 92 
dialog box, lost or missing • 132 
DICOM storage commitment • 85 
digital markers • 45 
disk 
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eject CD from drive • 84, 92 
record images on CD • 84 

Dorsal/Ventral hanging • 45 

E 
Edit menu • 75, 110 
Edit Outputs 

new groups • 80 
tab • 79 

Edit Patient button • 108 
edit patient data • 60 

on an accepted image • 62 
with MWL and PACS • 15 

Edit Procedure button • 108 
location • 37 

Edit Users • 76 
Edit View • 53 
Eject CD • 92 
Emergency Off switch • 25, 26 

restart system after use • 26 
use • 25 

error message, Incorrect Paddle • 124 
error messages see alarms • 135 
Exit • 74 
exposure 

AEC adjustments settings • 41 
information pane • 37 
status • 43 
with incorrect icon and edit view button 

corrected after accepted • 53 
corrected before accepted • 53 

with incorrect icon and no Edit View button 
correct after accepted • 53 
correct before accepted • 53 

exposure modes 
AEC • 40 
change resets exposure techniques • 39 
default • 75 
diagram • 39 
select • 39 

exposure techniques • 37 
default settings • 75 
reset to system defaults • 39 
select • 39 

F 
File menu • 24, 74 
film label area • 45 
flowchart 

AEC Modes • 67 
Manual Mode • 65 
TEC mode • 66 

Full Compression Force, Startup defaults • 75 

G 
Gantry 

set up for screening • 69 
generator 

message pane • 37 
problem • 26 
related alarms • 131 
Reset button • 37 
status • 43, 70 

H 
Hanging options • 45 
Hard Drive Full alarm • 118 
hard drive, AWS computer • 83 
hints 

Artifact Evaluation test • 22 
Flat Field Calibration test • 21 
Phantom View and SNR/CNR tests • 22 

I 
icons, system ready for exposure • 70 
Identify Yourself • 5 
Image Management 

Repreview • 87 
Resend • 86 

printing options • 86 
use • 85, 86, 87 

Image Pane, film label area • 45 
Image Preview screen • 44 
Image Repetition Information dialog box • 49 
Image Review Function • 115 
image spool • 122 
Image Status, alarms in queues • 132 
images 

accept or reject • 48, 73 
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acquire • 43, 70 
cropping, automatic • 48 
delete • 116 

from Reject Bin • 122 
rejected • 120 

DICOM attributes • 120 
import • 93 

files from CD • 84, 93 
manage • 85 
outputs see Outputs • 51 
preview • 44, 73 
printing • 114 
problem jobs • 81, 90 
query spool • 85, 113 
recall • 115 
reclaimed • 83 
rejected • 49, 73, 78, 119 

log • 73 
outputs • 43 

repreview • 87 
reprint • 85 
resend • 85, 112, 113, 116 

post procedure • 14 
rejected • 120 
to new output • 51 

retrieve on review workstations • 85 
rules for automatic reclamation • 83 
send accepted to outputs • 78 
store • 73 
technologist initials • 107 
temporary storage • 82 
thumbnails • 52 
view full resolution • 47 
view rejected • 120 

as report • 119 
in Review screen • 73 

work with • 44, 58 
Implant exposure techniques • 10 
implant present 

button • 45 
correct information 

after accepting • 46 
before accepting • 45 

implants 
displaced views • 10 

general information • 6 
print images • 11 
procedures • 10 

import 
image files • 93 
priors in background • 94 

incorrect information, places to remove • 62 
incorrect view selections 

correcting with an Edit button • 88 
correcting without an Edit button • 53 
how to correct • 53 

Info menu • 97 
invalid paddle, reconfiguring • 124 

J 
job status 

determine • 92 
viewing • 81 

L 
laser printer • 85 
Launch, see Wait Time • 23 
light field lamp 

use • 69 
Local Exams 

delete Patients from • 117 
description • 29 
Local Exams tab • 28 
names • 35 
results too long • 34 
search • 33 
sources of data • 29 

Local Exams tab • 28 
localization 

hints for procedure • 12 
procedures • 71 

log backups, mgr function • 124 
log in and out of application • 23, 24 
Log Out • 25 

Log out of the computer • 3, 4 

M 
Magnification modes, defaults • 75 
Main menu functions • 74 

by user • 108 
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maintenance, system • 107 
Manage Queues • 90, 91, 92 

delete (cancel) job status • 92 
determine job status • 92 
resend stopped job status • 92 

Manual exposure mode, technique default 
options • 75 
Markers, digital • 45 
Measurement tool • 47 
memory, rotation switches • 69 
menus 

Admin • 85 
Edit • 75 
File • 74 
Info • 97 

messages, see alarms • 135 
Modality Worklist • 28, 30 
MPPS, close a procedure • 58 

N 
network storage • 85 
New 

Procedure • 60, 61 
No Outputs warning • 43 
Non-Imaging Mode 

button • 63 
use • 63 

O 
Operating System logon level 

menu options • 112 
output images to CD • 84 
outputs • 78, 85 

accepted images • 48 
add new • 79 
change Resend printer options • 86 
change/select destinations button • 59 
delete • 78, 81 
described • 78 
edit • 80 
none • 43, 51 
on network • 82 
pane location • 37 
printer • 85 
queues • 81, 90 

rejected images • 43 
remove incorrect information from • 62 
retry job options • 90 
select • 43 
send 

accepted rejected images to • 50 
images to destination devices • 51 

spools • 51 
use after procedure closed • 14 
use new • 82 

P 
paddle alarms • 13 
paddle configuration, add or change views • 124 
Panel Power dialog box • 26 
password 

change • 77 
for Administrative reports • 126 

patient 
archiving many • 116 
correcting wrong information • 15 
data conflicts, resolve • 144 
data, how to enter • 33 
deleting • 117 
demographics • 29 
edit data • 60 

with MWL and PACS • 15 
find on a CD • 13 
lists • 29 
Name tab for local database • 33 
pane on Patient View screen • 37 
protect from reclamation • 89, 118 
search local database • 35 
with rejected Images • 119 

Patient Close button • 108 
Patient Query 

how to enter patient names • 35 
Patient View screen • 58 

options chart • 38 
thumbnails • 52 

position patient • 69 
Power off the computer • 24 
PPS status • 96 

menu item • 74 
Pre-compression force, startup defaults • 75 
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Preview Image • 44, 73 
Print Image Processing Options • 86 
printer • 87 

adjust contrast and brightness • 86, 114, 123 
change resend options • 86, 114, 123 
configuration • 85 
copies of images • 86 
test patterns • 96 

problem jobs 
in output queues • 90 
not reclaimed • 81 

procedure 
add another 

to open patient • 61 
with new accession number • 60 
with same accession number • 61 

Add or Edit buttons • 59 
choose • 36 
saving incomplete • 58 

program terminated • 140 
Progressive Preview • 44 
Protect Patients • 83, 89 
protect Weekly QC • 19 

Q 
QC 

hints • 21, 22 
protect Weekly QC patient • 19 

query • 30, 35 
images in spools • 85 
Modality Worklist Provider • 31, 33 
retrieve priors results • 94 

queues 
manage • 90, 91 
number of Jobs in Queue • 37 
output • 81 

Quick Zoom/Pan • 46 

R 
radiation icon 

changes color during x-ray exposure • 70 
system ready indicator • 70 

Ready • 43 
status • 70 

rebooting the computer • 25 

reclaimed, problem jobs not • 81 
reclamation 

Image spool • 51 
rules for automatic • 83, 118 

Region of Interest (ROI), button • 47 
reject accepted image • 51 
Reject Analysis 

Office Computer • 19, 20 
report • 127, 128 
Shortcut on the Desktop • 20 

Reject Bin • 117, 119, 122 
empty • 20 
managing • 119 
see Reject Management • 119 

reject image • 48, 49 
Reject Management 

deleting images • 122 
reject bin percentage full • 119 
resending images • 123 
view patient's rejected images • 120 
view rejected images report • 122 

Reject Spool Full Alarm • 122 
Rejected Images • 119 
removable storage • 82 
Remove Unexposed Views button • 59 
Repreview 

images • 85 
tab • 115 
use • 87 
window • 115 

Reprint image • 114 
Reprocess View • 45, 46 
Resend • 85, 86, 113, 114 

images • 11, 14, 86, 112 
Images from Reject Bin • 123 
mgr functions • 114 
resend stopped job • 92 
tech functions • 85 

resend stopped job • 92 
reset generator • 26, 131 
resolve patient data conflicts • 144 
restart computer • 25 
restart system after Emergency • 26 
Retrieve Priors • 94 
Review • 64 
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use to reject Accepted image • 50, 51 
view tab • 50 

RIS code, unknown • 143 
rotation switch memory • 69 
Ruler tool, see Measurement tool • 47 
Rules for automatically deleting images • 118 

S 
screening procedure • 68 

Mammogram w/Implants • 10 
screens 

locked up or missing • 132 
non-functional, but cursor moves • 140 
Patient View • 52, 58 
Preview Image • 44 
Review dialog box • 50 
Select a Patient 

functions available on • 27 
Standard Setup • 75 

search • 36 
for Patients • 33 
local database • 33 
Local Exams • 33 
Modality Worklist • 30, 33 
retrieve priors • 94 

select 
AEC sensor position • 42 
exposure modes • 39 
exposure techniques • 39 
more than one procedure • 61 
screening options • 68 

Select a Patient screen • 27 
chart of options • 27 

send 
accepted rejected images to outputs • 50 
images to outputs post procedure • 14, 86 

sensor position, AEC • 42 
sequence for screening • 68 
set Center/Width • 48 
set exposure techniques • 39 
sign in as a different user • 25 
Sign Out • 5 
Simulate Capture, button • 64 
Sleep mode • 3, 4 
SMPTE pattern • 96 

software 
version • 97 

specimens • 71 
spool 

alarms for image status • 132 
deleting images from • 117 
jobs waiting when you exit • 3, 4, 25 

Spool Management • 112 
Delete tab • 116 
manage space in image spool • 112 
menu item • 112 
mgr • 112 
Resend • 113 

density, adjusting for reprinting • 114 
using • 112, 114 

Standard Setup screens • 75 
Start-up Wait Time • 23 
store image on removable media • 82 
switch users • 5 
switches 

Emergency Off • 25 
Synchronization • 29 
system 

default setup choices • 75 
message area • 37 
messages • 23, 135, 139 
paddle messages • 13 
ready indicator • 70 
start up and turn off • 4 

system log files, backing up to CD-R • 124 

T 
tab, Delete • 116 
TEC 

(Tissue Exposure Control), described • 5 
Exposure mode • 66 
flowchart • 66 
technique default options • 75 

tech, access level • 107 
techniques, exposure • 37 
temperature (IR) • 97 
test patterns • 96 
thumbnails • 50, 52 
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U 
unreject an image • 17, 50 
user interface • 23, 74 
User Setup function • 76 
users 

access levels • 107 
add, edit and delete • 76, 77 
identification, profiles, rights • 107 
log in different user • 5 
sign in different • 25 

V 
view 

add • 59 
icon • 52 
image status in output queues • 90, 132 
paddle configuration • 124 
prior images on AWS • 94 
rejected images • 49, 120 
Rejected Images Report • 122 
select • 52 

View Order Editor • 76, 110 
View Selection, change • 55 

W 
Wait Time • 23 
Weekly Quality Control • 19 

protect • 19 
Window/Level • 48 
workflow 

clinical procedures • 68 
optional operations • 73 

worklist • 30, 144 
local • 29 
Modality • 33 
problems • 143 
resolve patient data conflicts • 144 

write images to CD • 84 

X 
X-ray 

acquire image • 70 
indicators • 70 

change when in use • 43 

Z 
Zoom/Pan • 46 
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